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uvOoD

Zahvaljujemo se vam za nakup naSega laserskega stroja. Na$ stroj so izdelali strokovnjaki.
Opremljen je z visoko tehnologijo.... za dobro delovanje stroja in njegovo vzdrzevanje
uporabljajte ta priro¢nik in podrobna varnostna navodila. Pred uporabo bi moral vsak uporabnik
natan¢no prebrati ta priro¢nik, saj vam bo v pomo¢ pri vzdrzevanju in delovanju stroja.

Veseli bomo vasih opomb in predlogov, ki jih bomo cenili!



Varnostno opozorilo!

Pred samo uporabo stroja morajo uporabniki laserja skrbno prebrati to navodilo. Strogo se drzite
predpisov za uporabo. Ljudem, ki niso usposobljeni za delo s strojem, uporaba stroja ni
dovoljena. Stroj ima laser razreda 4 (mocni laserski Zarek). TakSno lasersko sevanje lahko ob
neposrednem stiku povzroci naslednje nesrece:

- gorljive snovi se ob stiku z laserskim zarkom hitro vnamejo,

- razli¢ni materiali, ki jih obdelujemo lahko povzrocijo drugacna sevanja, strupene pline in
Skodljive snovi. Neposredni direktni laserski zarek bo povzrocil telesno poskodbo (opeklino).
Lokacija stroja mora biti opremljena s protipozarno opremo (v blizini laserja mora biti gasilski
aparat! Prepovedano je graviranje na vnetljive in eksplozivne materiale, prav tako jih je imeti v
blizini laserja. Neusposobljenim delavcem je delo z laserjem strogo prepovedano!

Uporabnik naj skrbno preuci, ali so materiali, ki se obdelujejo z laserjem primerni za delo z
njim ter ¢e je delo na laserju tvegano zaradi plinov, ki se sproscajo ob graviranju ali rezanju.

V laserskem stroju je visoka napetost in druge potencialne nevarnosti. Neusposobljenim
upravljavcem ni dovoljeno posegati v stroj!

Upravljavec nikoli ne sme zapustiti stroja med njegovim delovanjem. Izklopiti mora stikalo za
vklop, ko konfa z delom. Ne odpirajte pokrival/vrat med delovanjem stroja. Pred
delom/uporabo mora biti stroj ozemljen!. Strogo je prepovedano graviranje materialov, Ki
odbijajo svetlobo (ogledala in podobno), ker lahko povzrocijo pozar na predmetih okoli stroja
in poskodujejo stroj.

Upravljavec mora previdno opazovati delovanje stroja. Ce se pojavi napaka mora nemudoma
izklopiti stroj.

Lokacija stroja:

Stroj mora stati fiksno na suhem in ¢istem obmocju, kjer ni mocne elektrike in magnetizma.
Temperatura mora biti 5-40°. Okoljska vlaga bi morala biti 5-95% (brez zgoS¢ene pare).
Priporoc¢eno je, da se poleg stroja uporablja elektro filter, ki izni¢i sunke oz. nihanja el.
napetosti, ki lahko povzro¢i neenakomerno delovanje stroja.

Normalna napetost: AC230V, 50 Hz, prepovedano je odpreti stroj, ¢e je napetost elektricnega
toka neenakomerna ali slaba.

Proizvajalec ne bo prevzel odgovornosti zaradi nepravilne uporabe stroja oz. neupostevanja
zgoraj omenjenih predpisov s strani uporabnika.

VZDRZEVANIE Laserskega stroja:

Vodila je potrebno vsakih 7 dni dela temeljito pocistiti z razred¢ilom in kasneje
namazati z viskoznim teflonom.

LECO je potrebno &istit vsake 3 delovne dni z vatiranimi pal¢kami in &istim
alkoholom.Nikoli ne ¢istite leCe z agresivnimi teko¢inami



1. poglavje: Videz stroja in dodatki
1.1.1. Videz stroja (razli¢ni model bo imel drugacen videz na podlagi realnega objekta).
Pravilna stran je prikazana na sliki F1-1.

F1-1

Hrbtna/zadnja stran je prikazana na sliki F1-2.

F1-2



1.1.2 Dodatna oprema
Dodatna oprema vsebuje naslednje dele (razen opcijske rezervne dele):
vodna cev (zra¢no cev), zracna cev in vodna crpalka (nekatere so namescene v vodnem

bazenu) so prikazane na sliki F1-3:
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2. Sesalni ventilator in dimna cev sta prikazana na sliki F1-4

o S <

F1-5



1. Hladilnik je prikazan na sliki F1-6:
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2. Priro¢na torba in notranji dodatki so prikazani na slikah F1-7, F1-8.

F1-7 | F1-8

6. Zemeljska zica je prikazana na sliki F1-9 (kupec jo mora namestiti sam)



I 2. poglavje: namestitev in priprava stroja

Celoten delovni sistem je sestavljen iz laserskega rezilnega sistema, sesalnega ventilatorja,
zracne Crpalke, vodne crpalke, vodnega bazena, prenosa podatkov in tako dalje. Glede na
potrebe lahko uporabniki sami konfigurirajo ra¢unalnike, tiskalnike, skenerje, itd.

2.1 Koraki namestitve in uravnavanja
1. Namestitev laserske cevi

Ker je lasersko steklo zelo krhko, bi se moralo le to spraviti posebej, da se zagotovi njena
varnost med prevozom. Tako mora uporabnik namestiti lasersko cev pred namestitvijo in
pripravo stroja.

Laserska cev se namesti na zadnjo stran stroja, odprite za$¢itna pokrivalo/vrata laserske cevi
(glejte obe V-blokadi), kot je prikazano na sliki F2-1.

F2-1

Previdno povlecite svetlobno okence (nizko napetostno konico) laserske cevi z isto stranjo
zrcala (reflektorja) Stevilka 1 na V-blokadah in potem na gumah V-blokad dobro zaprite
prevleko laserske cevi, zatisnite/fiksirajte lasersko cev, kot je prikazano na sliki F2-2.



F2-2

Opozorilo: Da bi se izognili poskodbam, laserska cev ne sme biti pretesno
stisnjena. Poskrbite za to, da bo odprtina za vodo (visoko napetostna stran laserske
cevi) locirana na dnu cevi zaradi polnjenja laserske cevi z vodo.

Po fiksiranju laserske cevi mora biti cev za donos vode (odprtina), ki je povezana
z vodnim senzorjem, povezana z visoko napetostno vodno odprtino laserske cevi
(v primeru mrzlega vremena in zloma laserske cevi, dobro ogrejemo konico vodne
cevi s prekuhano vodo in jo tako omehc¢amo, kot je prikazano na slikah F2-3 in
F2-4).

F2-3 F2-4

Vsi vezniki morajo biti trdno pritrjeni, da se prepreci izliv vode. Gumijasta cev mora biti
ravna. Da bi se izognili slabemu pretoku vode, le-ta ne sme biti zvita. Za konec mora visoko
napetostni kabel laserskega elektricnega dotoka biti povezan z nizko napetostno glavo
laserske cevi, kot je to prikazano na slikah F2-5 in F2-6.



F2-5 F2-6

Iz varnostnih razlogov ucvrstite/zamasite glavo visoko napetostne strani in nizko napetostne
strani s silikonskim gelom.

Namestitev vodne ¢rpalke

Prosimo, nalijte Cisto vodo v vodni bazen (raven vode naj bi bila visja vsaj od cevi). Odvodna
¢rpalka naj bi bil povezana z dovodno odprtino stroja in drugi del vodne ¢rpalke naj bo povezan
z odvodno odprtino stroja. Drugo stran vodne cevi dajte v vodo in zakljucite krozeCopovezavo
vodne cevi.

Kakor prikazujeta sliki F2-7 in F2-8, priklju¢i napajalnik vodne érpalke, zdaj lahko vidimo,
da se laserska cev postopoma polni z vodo. Ce voda tekoée tete skozi odvodne cevi, to pomeni,
da ¢rpalka deluje pravilno. Za zagotovitev normalnega pretoka hladne vode skozi lasersko cev,
je v vodnem reciklaznem sistemu namescen vodni zaséitni senzor. Med slabim delovanjem
vodnih ¢rpalk, se bo laserski stroj za graviranje samodejno preklopil v zas¢itno stanje. Laserska
cev ne bo oddajala laserske svetlobe. Zato bodite pri vzdrzevanju rutine pozorni na ¢iste vodne
¢rpalke in vodne cevi.

2. Namestitev zrac¢ne ¢rpalke

Zracna cev naj deluje kot povezava za izhajanje zraka iz ¢rpalke in njegovo vstopanje v
stroj za graviranje. Poskrbite za normalno prezracevanje po vklopu/vzigu, kot je to
prikazano na slikah F2-9 in F2-10.

r

F2-9 F2-10



V tem sistemu ima zracna ¢rpalka izreden pomen. Visoko napetostni zrak se giblje skozi
zracne cevi in piha skozi okno laserske glave, ki oddaja lasersko svetlobo. Po eni strani
lahko zagotovi ¢isto¢o, po drugi strani pa lahko prepreci vnetljivost snovi laserske svetlobe.
Zato mora upravljalec pozornost nameniti zra¢ni cevi. Poskrbeti mora za to, data ni
ukrivljena ali poskodovana, drugace lahko odveéen zrak vodi do gorljivih snovi.

3. Namestitev sesalnega ventilatorja

Dimna cev mora povezovati sesalni dovod ventilatorja z odprtino laserskega stroja, ki
izsesava prah. Vse tri fiksirajte s kljucavnico. Vzemite drugo dimno cev in jo povezite s
sesalnim odvodom ventilatorja. Drugi konec dimne cevi naj ostane nepovezan/mora gledati
navzven. Za konec dobro prikljucite napajalno zico, kot je prikazano na slikah F2- 11 in F2-
12.

F2-11 F2-12

5.Varna ozemljitev

Laserski gravirji tehnologije Morn uporabljajo $tiri vrstno lasersko cev. Pogon je visoko
napetostni, zato morajo upravljavci stroja med njegovo uporabo upostevati varnostna opozorila.
Po drugi strani zahtevajo varnostna navodila od upravljalca, da se strogo drzi pogojev/zahtev
varne ozemljitve. Napetost/odpornost tal mora biti manj kot 5 Ohmov. Specificna metoda
prikljucitve/povezave je prikazana na slikah F2-12 in F2-13.

Opozorilo: slaba ozemljitev lahko povzro¢i veliko verjetnost nedelovanja opreme in hkrati
druge varnostne incidente!!! Podjetje ne bo prevzelo nobene odgovornosti ali obveznosti v
primeru napake ali nesrece zaradi slabe ozemljitve.

Opti¢na pot

Vsi napajalni vodi naj se povezujejo in napajajo z elektricnim tokom. Vklopite napajalnik
gravirnega stroja. V tem Casu se stroj zazene ponovno in vrne na zadnjo izvirno toc¢ko. Vse
zgoraj kaze na to, da stroj deluje normalno. Sprozi laserski napajalnik in za¢ni z uravnavanjem
opti¢ne poti, kakor kaze slika F1-14:



F2-14

Uravnavaj nastavitev laserja. Zaloga vecslojnega papirja naj bo na uokvirjenem zrcalu. Nato
pritisnite tipko »Pulse« na nadzorni plo§¢i. Na papirju se pojavi zazgana tocka. Preverite, ali je
svetloba na sredini zrcala. Ce svetloba ni na sredini zrcala, jo moramo postaviti na sredino zrcala
tako, da reguliramo lokacijo (uravhavamo lego) laserske cevi.

Potem regulirajte odbojna zrcala (reflektorje). Zarke pomaknite tako, da bodo najblizje
reflektorju. Pritisnite »Pulse«, da se svetlobna tocka/mesto prikaze na papirju. Nato pomaknite
zarke dale¢ stran od reflektorja in najdite $e eno tocko na papirju. Kote zrcal uravnamo tako, da
poravnamo Vvse tri vijake na hrbtni strani zrcala (vrtenje zgornjega vijaka v smeri urinega
kazalca, to¢ka/mesto bo spodaj; vrtenje spodnjega levega kota vijaka, svetlobna tocka se
pomakne na levo), da zagotovimo, da so vse tocke na papirju na pravem mestu in kdaj ter kam
pomikamo Zarek.

Potem, ko dobro uravnamo zrcalo reflektorja, moramo nato uravnati zrcalo, lasersko glavo
pomaknemo najblize reflektorju. Nato dolo¢imo svetlobno tocko na papirju. Naslednjo
mesto/tocka se mora prekrivati s prvim mestom/to¢ko. To naredimo tako, da vrtimo vijake na
okviru reflektorja.

Opozorilo: najboljse je, da je lokacija svetlobne tocke na sredini zrcal. Svetlobna toc¢ka se ne
sme dotikati robov zrcal. Ce pa se znajdejo na robovih, potem $e naprej uravnavajte zrcala,
dokler se svetlobna toc¢ka ne bo znasla na sredini zrcal.

Nazadnje moramo preveriti, ali so svetlobne tocke dobro postavljene, ne glede na lokacijo
laserske glave. Ce tocke ne sovpadajo, prosim, ponovno uravnavajte optino pot na zgoraj
opisani nacin vse do sovpadanja/prekrivanja tock.

Po uravnavanju bomo preverili, ali je ta laserska tocka na sredini svetlobnega jaska laserske
glave. Ce temu ni tako, izklopite laserski napajalnik in prilagodite nastavitev laserske cevi. Ali
gre za levi ali desni odklon- ne glede na to, pomaknemo lasersko cev na tisto stran, na



katero je nagnjena. Na primer, ¢e je nagnjena na levo stran, jo pomaknemo na levo, ¢e pa na
desno, pa jo pomaknemo na desno stran.

Ce nagibanje niha, moramo lasersko cev povleci na nasprotno stran. To pa pomenti, da se nagiba
gor, povlecemo lasersko cev dol, ¢e pa gor, bomo povlekli lasersko cev gor.

Opozorilo: zgoraj opisana navodila za uravnavanje laserske cevi so misljena samo za nizko
napetostno stran laserske cevi (svetlobna stran). Ko pa Zelimo dose¢i isti u¢inek z uravnavanjem
visoko napetostne strani, potem je smer uravnavanja nasprotna.

Za podrobne informacije o tem, kako uravnamo opti¢no pot, glejte poglavje 4 (uvrstitveni
standardi opti¢ne poti).

Po uravnavanju opti¢ne poti, prosim zaprite zas¢itno pokrivalo laserske cevi.



3. poglavje

Upravljanje z laserskim strojem

Poleg racunalnika za nadzorovanje tipke (gumbe) delovanja lahko uporabljamo nadzorno
plosco. V nadaljevanju vam bomo predstavili nadzorno plosco in njeno glavno funkcijo.

Nadzorna plos¢a ima 16 tipk delovanja/funkcijskih tipk in en LCD zaslon.

Predstavitev vmesnika
1.3.1
Glavni vmesnik 1 (ne deluje)

Datoteka FILE : XXX
Maksimalna moé¢: XX.X%

Hitrost : XXXmm/s
Nedelujo€ ...

Glavni vmesnik 2 (deluje)
Datoteke  : XXX

Maksimalna mo¢: XX.X%

Hitrost delovanja: XXXmm/s
Delovanje : XX: XX: XX



Glavni vmesnik 3 (pavza)
Datoteka : XXX

Maksimalna mo¢ : XX.X%

Hitrost delovanja: XXXmm/s
Pavza : XX: XX: XX

Ko stroj ne deluje, se pojavi vmesnik 1. Navzoca datoteka (ki se pojavi) vam bo pokazala
»000« (to pomeni, da ne izberemo spominske datoteke). Videli bomo najve¢jo mozno moc ter
hitrost graviranja na zaslonski ploséi, to je najve¢jo mozno porabo energije, izrazeno V
odstotkih, ki ustreza natanc¢no 0.1 % in hitrost z enoto v mm/s. Seveda lahko pritisnemo tipko
pod 1. glavnim vmesnikom, toda nekatere tipke/gumbi pod 2. in 3. vmesnikom ne bodo
delovale.

1.3.2 Predstavitev gumba
Ponovni zagon

»RESET« gumb je namenjen resetiranju stroja, kar pomeni, da se ob pritisku na ta gumb glava
zapelje v kot do kon¢nih stikal in si nastavi pravilno pozicijo. Po resetiranju se glava vrne v
prvotno pozicijo in je stroj pripravljen za delo.

POZOR: med resetiranjem je PREPOVEDANO stiskati tipko »ESC«, ker v tem primeru
dodelimo stroju delovno obmocje 10m in bi lahko zaradi tega prislo do posSkodbe glave, saj bi
le -ta udarila v stroj izven delovnega obmodja!

Stroj se bo zagnal v vseh stanjih. Glavni racunalnik se bo zagnal in stroj se bo vrnil v prvotno
stanje in deloval, zaslon LCD pa bo prikazal »ponovni zagon sistema«. Po uspeSni vrnitvi v
prvotno stanje, se bo stroj vrnil na zadnje prvotno stanje. Ce bo zadnja naloga/delo dokonéano,
se bo na zaslonu pojavil prvi glavni vmesnik. Ce zadnja naloga ne bo dokonéana (stroj ni bil
zagnan med delovanjem), bo sistem prikazal naslednje:

Power Off Rework (zaustavljen, ponovno delo)

OK (v redu)
Esc (tipka Esc ali nazaj)

Ce pritisnemo tipko Esc (nazaj), stroj ne bo deloval sproti. Sistem se bo vrnil 1. glavnemu
vmesniku. Ce pa pritisnemo »enter« (slov. vnesti), bo stroj nadaljeval z delom in graviral sliko,
ki pred izklopom stroja ne bo dokon¢ana. Pomnite, da potem ko pritisnemo »enter«, se bo na
LCD zaslonu pojavil zapis »iskanje to¢ke za zaustavitev sistema, prosim, poéakajte.« Cakalni
¢as je povezan z zadnjo koli¢ino obdelanih podatkov. Vecja je koli¢ina podatkov, daljsi je
Zakalni Gas. Ce je sistem zaustavljen, potem ko je graf eno uro obdeloval podatke, traja iskalni
¢as eno minuto.



Laser



Ta gumb lahko pritisnemo, ko je stroj v stanju mirovanja (nedelovanja) ali pavze. Ko pritisnemo
to tipko, prihaja laserska svetloba iz laserske cevi. Cas oddajanja svetlobe se ujemas Gasom
pritiskanja na tipko. V trenutku, ko pustimo tipko, laser preneha. S pritiskom in usmerjanjem
tega gumba lahko izrezujemo materiale. Laserska mo¢ je najvec¢ja mozna mo¢ na LCD zaslonu.
Gumb ni uporaben, ¢e je v drugem stanju. Med nedelovanjem sistema za hlajenje vode ne bo
laserja. Prav tako se bo na zaslonu LCD prikazalo obvestilo o napaki.

Parametri

Min Power — najmanjSa mozna mo¢

Max Power- najve€ja mozna mo¢

Speed Hitrost

Obstajajo trije parametri: minimalna mo¢, maksimalna moc in hitrost. Parametre lahko
prilagodimo vsem trem glavnim vmesnikom (nedelovanje, delovanje in pavziranje,
mirovanje). Ko stroj deluje, lahko vidimo parametre na zaslonu LCD. Ko programska
oprema izrezuje/gravira datoteko, ¢e se eden od parametrov (maksimalna moc,
minimalna moc in hitrost) oz. vsi parametri premaknejo na 0, bodo ustrezni parametri
na LCD zaslonu presli v stanje nedelovanja. Ko enkrat zachemo z delom, se bodo
pojavili parametri na LCD-ju.

Odlocite se na primer za hitrost (angl. speed). Ko boste pritisnili to tipko, se vam bo
na zaslonu prikazalo naslednje:

Hitrost: XXX mm/s
OK Or Esc
Vmesnik 5

Lahko se odlo¢imo za parameter, ki ga zelimo uravnati s pritiskom na tipko, kiusmerja
levo ali desno, in potem spremeniti smer s tipko gor ali dol. Shranimo ga lahko s
pritiskom na tipko »O.K.« (ang. v redu). Preklicemo ga s pritiskom na tipko
»Esc«.



Pri parametrih minimalna moc¢ (ang. min power) in maksimalna mo¢ (max power) je
podobno. V stanju nedelovanja vpliva sprememba moci in hitrosti na naslednje
parametre delovanja: zvok tipke, laser in rocno premicno os. Spremeni te tri parametre,
ko stroj deluje in nato samo spremeni nadaljnji u€inek obdelovanja. Ne vpliva na
parametre, ki so pod stanjem nedelovanja. To ne bo vplivalo na lazeCe parametre.

Spletno spreminjanje obdelovanja lezeCih parametrov prepricajo uporabnike v to, da
se ustrezna laserska moc in hitrost pokrivata.

(4) Datoteka

Dat

Vidimo lahko spodniji zaslon, ko pritisnemo tipko datoteka, ko je stroj pod stanjem
nedelovanja:

MemoryFile Spominska datoteka
UdiskFile Udisketna datoteka
TrackFrame Sledi
Del All Memo File Zbrisi vso spominsko datoteko
Vmesnik 6 Vmesnik 6

Za datoteko se lahko odloCimo z usmerjanjem tipke desno ali levo. Pritisnemo
»enter« za vpogled v naslednjo datoteko. »Datoteke« nam ne bo prikazal, ¢e ni
datoteke v »spominski datoteki« ali »u disketni datoteki«. Ce pa datoteka obstaja,
bomo videli ime in informacije na datoteki na zaslonu LCD. Na LCD zaslonu lahko
vidimo 4 datoteke:

XXXXXXXXXXX
XXXXXXXXXXX

XXX XXX XXX XX
XXX XXX XXX XX
Vmesnik 7

Izberemo lahko datoteko z usmerjanjem tipk (gor in dol se uporabljata za
spreminjanje tocke in leva in desna tipka pa za spreminjanje strani), nato kliknemo
wenter«, da vstopimo v naslednji vmesnik. V pomo¢ je naslednjim Stirim
funkcijam: »zazeni«, »sledi«, »ToUsb«, »zbriSi«.



Run-Zazeni
Track Frame-Sledi
ToUsb- k usb

kljucu

Delete-Brisi
Vmesnik 8

Stroj bo obdelal preverjeno datoteko, ko bomo izbrali »zazeni«, datoteko bo kopiralna
U disk, ko bomo izbrali »To Usb«, datoteka bo izbrisana, ko bomo izbrali »izbriSi«. Za
datoteke v U disku podpira dve funkciji, namre& »kopiraj« in »brisi«. Ce je kaj narobe,
lahko pritisnemo »enter« ali »esc« (»nazaj«), da jo shranimo ali prekli¢emo.

Glavna plos¢a lahko prepozna formatne datoteke FAT 32 in FAT 16. Te datoteke
moramo vstaviti v korensko datoteko U disk. Ve€ kot osem znakovne datoteke se
samodejno prerezejo. Ime datotek mora biti sestavljeno iz ¢rk ali Stevilk. Datoteke, ki
se kopirajo iz mati¢ne ploSCe na U disk, se premestijo v korensko datoteko.

Opcija »sledi« (ang. »Track Frame«) Sestega vmesnika pomeni track border za
trenutno izbrano spominsko datoteko (zadnjo obdelano datoteko). Opcija »Track
Frame« 8. vmesnika pomeni track border za posamezno spominsko datoteko. Ce je
izbrana katera od teh opcij, se spodaj prikaze vmesnik:

Blank X. XX mm
CutFrame

TrackFrame
DotCorner
Vmesnik 9

Pojdite v vmesnik 9, drsnik se nahaja v privzeti prvi opciji »prazno« ali (ang.
»blank«- prazno pomeni zunanjo razdaljo na podlagi dejanske velikosti grafa).
V tem cCasu lahko namestimo »prazno«, tako da pritisnemo na pusCice. Nato
pritisnemo »enter« ali »esc«, da nastavimo ali preklicemo namestitev. Potem ko
nastavimo prazno razdaljo, se bo drsnik vrnil v »prazno«. Izberemo lahko druge
opcije, tako da pritisnemo na pus€ici za navzgor in navzdol. Z opcijo »izreZi«
lahko izrezemo kon¢ni graf z rokami. »Sledi« pomeni, da se premikamo po meji,
da dosezemo okvirni predogled. Opcija »DotCorner« pomeni, da bo laser oddajal
svetlobo v stirih mejnih kotih. Skozi teh Stiri mest bomo lahko opazovaligrafi¢no
velikost in lokacijo. V tem ¢asu sta gibalna mo¢ in laserska mo¢ stroja nastavitve,
ki se pojavijo na LCD-ju, ko sistem ne deluje. Laserska mo¢
»DotConor« je samo povezana z maksimalno mocjo (angl. Max Power).
Opozorilo: Ce je graf prevelik oz. se lokacija nahaja koordinatah max/min,
lahko meja preseze koordinate max/min. Na tej tocki bo vmesnik pokazal preveé
informacij. Potem ko pritisnemo »enter« bo sistem sledil okviru v skladu s



koordinatami max in min. Za »rd.«, to je datoteka, ki je produkt starejse
programske opreme, bo vmesnik pokazal »ni okvirnih informacij pri upravljanju
z datoteko rd.«. Ko bomo uspesno zaceli uporabljati mejo, bo vmesnik pokazal

DICRNEIEER. V tem casu se prikazovalnik ne bo odzval na katere koli druge
gumbe, razen na »ponovni zagon« ali »reset«.

(5) Zacni/miruj

Start-
Pause

Zacni/miruj lahko pritisnemo v treh glavnih vmesnikih. Pritisni to tipko, ko
sistem ne deluje. Obdelal bo izbrane datoteke. Pritisni to tipko, ko stroj deluje, delo
bo mirovalo. Pritisni to tipko v vmesniku mirovanja in delo se bo nadaljevalo.

(6) lzvor
To tipko lahko pritisnemo, ko je sistem v stanju nedelovanja. Racunalnik bo prevzel os
X/Y trenutnih strojev kot zacetno delovno toc¢ko. Ta tipka ne velja za druge vmesnike.

(7) Jezik

Vmesnik Clovek-stroj podpira tri jezike. Ko sistem ne deluje, pritisni tipko »jezikg,
vnesi jezike. Obstajajo trije jeziki: poenostavljena kitajScina, tradicionalna kitajscina in
angle&cCina. Izberi jezik in pritisni »enter«, LCD bo potem prikazal ustrezen jezik. Ker v
naslednjem jeziku ni spremembe, bo nazadnje izbran jezik obveljal pred naslednjo
spremembo jezika (ponovno zazeni stroj).

Esc Enter

(=] =]

Pritiskanje tipk Esc ali Enter lahko potrdi ali preklice delovanje v vsakem
vmesniku.
Smerokazne tipke (gor in dol, levo in desno).

(A) (W) =] (m)

Smerokazne tipke se uporabljajo, da spremenimo parametre, premikamo os.
Pritiskamo lahko smerokazne tipke, da premikamo os v nedelovanju ali mirovanju.
Premikanje osi X na levo ali desno tipko in premikanje osi Y s pritiskanjem na tipkigor
in dol. Najvecja mozna hitrost premicne hitrosti s pritiskom na tipko je hitrost na zaslonu
LCD, ko je sistem pod stanjem nedelovanja.

10 Z/U tipka




Z/U tipka je na voljo v stanju nedelovanja. Spodnji vmesnik bo prikazal
naslednje po pritisku na tipko:

ZAexsMove
UAexsMove

ZAexsReset

ManualSet
Vmesnik 10

Lokacijo drsnika lahko spremenimo s pritiskom na smerokazne tipke gor in
dol. Ce drsnik ostane v premiku “ZAeksMove”, se bo os ob pritiskanju na tipko
za desno in levo smer premaknila.

Ce je premiéna razdalja v koraku ni¢, se bo os Z kontinuirano gibala ob
pritiskanju leve in desne tipke. Premik “UaecksMove” je podoben premiku
“ZaeksMove”. Ko drsnik izbere opcijo ponovnega zagona “ZaeksReset”, pritisni
“enter” in sistem bo zacel premikati os Z nazaj v prvotno stanje, vmesnik pa
vam bo pokazal, da se je je os Z ponovno zagnala. Po kon¢anem zagonu osi Z in
uspesni vrnitvi v prvotno stanje, ima os Z zascito koordinat Max in Min, tako
kot os X/Y. Os Z samodejno pospesuje in zavira, ko se premika v koordinatah
Max in Min. delovne mize. Ko drsnik izbere opcijo “nastavi korak™, pritisni
“enter”” In vmesnik pokaze naslednje:

Step Moving Distance/Premi¢na razdalja v koraku
XXX Xmm
Vmesnik 11

Nastavimo jo lahko s pritiskom na pusc¢ice. Niz premicne razdalje v
koraku vpliva na delovanje in na razdaljo v koraku stirih osi X/Y/Z/U.



4. poglavje
Nastavitveni standardi opti¢ne poti

Med obicajno uporabo lahko pride do odstopanja opti¢ne poti in s tem
posledi¢no tudi do nenormalne poti svetlobe ali do nepojavljenja laserja.

Prvi korak: najprej poskrbi za potovanje laserskega zarka od laserske cevi
do sredine prvega odsevnega zrcala/reflektorja.

Drugi korak: zalepi vecslojni dvojni lepilni trak na drugi reflektor (ali
oznaci druge predmete), laserski zarek priblizaj laserski cevi, pritisni pulz (utrip)
(izberi primerno moc), izberi mesto na papirju (posebno opozorilo: najprej
testiraj priblizno lokacijo svetlobne toCke s kartonom, da preprecis slabo
lasersko sevanje in nato uravnavaj).

1#

laser tube [:]

Ui, 32

A

Tretji korak: Zarek premakni na mesto, ki je zelo oddaljeno od laserske cevi, pritisni pulz innajdi
Se drugo mesto na papirju.



1#
;&Cﬁ laser tube E::l

Cetrti korak: &e tocki ne lezita ena nad drugo, uravnaj vijake na zadnjem delu prvega
reflektorja, tako da bi laser meril na tisto mesto, kjer je prva tocka.

Peti korak: ponovi korake od 2 do 4, tako da se bosta toCki popolnoma
ujemali/prekrivali. Poleg tega naj bodo toc¢ke na sredini luknje.

Sesti korak: na tretji reflektor prilepi ve&slojni dvojni lepilni trak, lasersko glavo priblizaj
drugemu reflektorju (zrcalu), pritisni pulz (izberi ustrezno moc€) in pois¢i tocko na

papirju.
1?&{:3 laser tube Ifl:l

A '

A4

Sedmi korak: lasersko glavo pomakni na mesto, ki je najbolj oddaljeno od
drugega reflektorja, pritisni pulz (da najprej odkrije$S ustrezno lokacijo laserja s
kartonCkom, da se prepreci slabo sevanje), nato pois¢i drugo tocko/mesto.

3#
2#

4#



Osmi korak: Ce ti dve toCki ne lezita ena nad drugo, uravnavaj/privij vijake na
zadnji strani drugega reflektorja, tako da bo laser meril na isto mesto, kjer je prva tocka.

Deveti korak: ponovi korake od 6 do 8, tako da se bosta toCki popolnoma
prekrivali. Poleg tega morata biti tocki na sredini luknje.

Deseti korak: na tretji reflektor prilepi vecslojni dvojni lepilni trak, pritisni pulz in
poiSci toCko na papirju. Ce je ta na sredini svetlobne tocCke, jo obidi.

Enajsti korak: Ce laserska svetloba ni na sredini svetlobne tocke, kakor kaze
spodnja slika, je treba narediti naslednje:

Na levi sliki se to¢ka nahaja zgoraj desno. Ce se to¢ka nahaja zgoraj na vrhu ali spodaj
na dnu, lahko to dvigne oziroma spusti lasersko cev. Lasersko cev pritisnite navzven
ali navznoter. S tem uravnavate tezenje toCke navzven ali navznoter. V tem primeru je
dobro spustiti lasersko cev (to je povezano z nizkonapetostno stranjo laserske cevi) in
nato od zaCetka ponovite prvi korak.

Opozorilo: upravljavec ni zmozen izvesti zgoraj opisane korake, ¢e ni strokovno
usposobljen. V drugacnem primeru mora upraviljavec izvesti ta dela s pomocjo
strokovnjaka. Upravljavec mora med uravhavanjem pozornost nameniti varnosti, da
prepreci slabo lasersko sevanje.



4. poglavje Dnevno vzdrzevanje in obiCajne napake

Stabilno delovanje stroja je tesno povezano z normalnim dnevnim delovanjem in
vzdrzevanjem. Tu je podana analiza obiCajnih napak in obiCajnega dnevnega
vzdrzevanja:

[.5.1 Dnevno vzdrzevanje:
1. Zamenjava hladilne vode (Cisti vodni bazen in zamenjava reciklirane vode enkrat
dnevno sta priporocljiva).

Kakovost in temperatura hladilne vode lahko neposredno vplivata na zivljenjsko dobo
laserske cevi. Zato predlagam uporabo precCiSCene in destilirane vode. Temperatura
vode mora biti nizja od 35 stopinj in Celzija. Ce je temperatura viSja od 35 stopinj in
Celzija, zamenjaj hladilno vodo in dodaj ledene kocke ter zmanjSaj temperaturo vode
(priporoca se hladilna naprava ali uporaba dveh vodnih bazenov).

Opozorilo: poskrbi za to, da je laserska cev napolnjena s hladilno vodo pred
delovanjem stroja.

2. Cis&enje vodnega bazena

Najprej izklopi stroj, prekini dovodno cev in samodejno spusc€aj vodo iz laserske cevi
v vodni bazen, nato odpri vodni bazen, izvzemi vodno €rpalko in jo ocisti. Ocisti tudi
vodni bazen, vstavi vodno cev, ki povezuje vodno ¢rpalko z dovodno odprtino stroja,
zatisni vse Clene in zamenjaj hladilno vodo. Posebej/na samem vklopi vodno Crpalko
in jo pusti delovati od 2 do 3 minute (laserska cev naj bo napolnjena z vodo).

3. Ciséenje izpudnega ventilatorja

Po dolgoro¢ni uporabi se znotraj ventilatorja nabere trdi prah. Tako nastane zaradi
ventilatorja hrup, ne pa posledi¢no tudi iztroSnja. Ko izpraznovanje postane slabo,
moramo pocistiti ventilator in dimno cev. Najprej izklopi izpusni ventilator, obe cevi
odstrani z ventilatorja, pocisti prah znotraj cevi in nato Se prah znotraj ventilatorja.

4. Cis&enje le¢ (priporodljivo je dnevno ¢iséenje pred delom, oprema mora mirovati)
Kot smo Zze omenili prej, mora imeti rezalni stroj tri reflektorje in objektiv (prvi
reflektorje v blizini odprtine laserske cevi, iz katere izhaja svetloba, zgornji levi
kot stroja,drugi reflektor je na levi strani zarka, tretji pa na vrhu laserske glave,
objektiv pa senahaja na dnu laserske glave). Laser nastaja pod vplivom reflektorja
(zrcala, kiodseva) in objektiva, ki zaostruje. Zrcalo zlahka postane umazano, kar
posledi¢novodi do izgube laserja in poSkodbe zrcala. Med cis€enjem vam ni treba
premaknitiprvega, drugega in tretjega zrcala. Vzemite samo bombazni kos oblacila
in ganamocite v raztopino (aceton ali alkohol). Previdno pobriSite zrcalo, tako da
kosoblacila vrtite od sredine leCe do njenega roba.

Izvlecite objektiv iz laserske glave, oCistite ga na enka nacin in ga po cis€enju
vstavite naza;.

Opozorilo: previdno obriSite leCe, ne smete poskodovati povrSinske previeke. To
naredite narahlo, da leCe ne padejo. Pri nastavitvi objektiva naj bodo konkavne
pomaknjene navzdol.



5. Ci&enje traénice (priporo¢a se &id¢enje dvakrat tedensko, oprema moramirovati).
Najprej pomakni lasersko glavo na skrajno desno (levo), obriSi jo s suho krpo in malo
olja, tako da bo sijala (priporocCa se olje za Sivalni stroj), lasersko glavo nekaj krat poCasi
potiskaj po tracnici, tako da se mazivo razporedi enakomerno. OCisti in nhamazi obe
tracnici, tako osi Y kot osi X.

Opozorilo: Prosim, za CiS€enje pripravi: suho bombazno krpo in mazivno olje.

6. Pregled opticne poti

Sistem opti¢ne poti laserskega rezilnega stroja se kon€a z odsevanjem zrcala in
zaostritvijo objektiva. Opticna pot je nagnjena k objektivu, toda vse tri zrcala so pritriena
z mehani¢nim delom. Obstaja verjetnost, da bo opticna pot nagnjena k zrcalom. Kljub
temu te nagnjenosti/teznje opticne poti obi¢ajno ni, zato vam pred delom predlagamo
pregled opticne poti.

Podrobno razlago o tem si preberite v 4. poglavju »Nastavitev standardov optiCne
poti«.

Analiza obicajnih napak

Pojav/mozno

St. slabo Metoda analize Resitev
delovanje

Preveri, ali napajalnik stroja | Ponovno elektriziraj
dobro prevaja napajalnik.

Odpri stroj : i
1 ) o Popravi parametre na podlagi
brez premika | Parameter glavne plosce je .
_ _ navodil za uporabo
pravilen ali ne
programske opreme.
Delo s _ Popravi parametre na podlagi
. Parameter glavne plosce je P . P podiad
2 stalnim _ . navodil za uporabo
. pravilen ali ne
laserjem programske opreme.
Slaba Preveri, ali je krozenje vode | Ocisti vodni bazen, vodno
plavajoce ali ne ¢rpalko in vodno cev
3 | svetloba med : :
. . ) ) Dodaj regulator za laserski
delovanjem | Napetost je stabilna ali ne .
stroj
Samodejni : -
test na Popravi smer osi X In'Y,
) Parameter glavne plosce je parametre nastavi glede na
4 zaCetku/ob . . o :
Zagonu pravilen ali ne. priro¢nik delovanja
rogramske opreme.
abnormalen Preg P

5 Po Preveri, ali je mesto podatkov | Izberi pravilno mesto.




uporabi/nasta | pravilno.
nku podatkov | Preveri, ali je stroj vklopljen | Vklopi stroj
stroj ni Preveri, ali je zemeljska zica . L
. . Priklopi zemeljsko Zico.
deloval za stroj priklopljena.
Preveri,
ali je nastavljen USB Nastavi USB gonilnik
gonilnik
Ni laserja Preve-:ri, ali je opti¢na pot Nastavi opticno pot
med nagnjena
delovanjem | Preveri, ali hladilna voda tece | Poskrbi za tok vode
Ni mogoce
odKkriti problem komunikacije prek .. o
i . Zamenjaj racunalnik ali USB
lasersko racunalnika ali USB-ja. Jej racunaind

opremo




I RDCAM V3.0 Navodila za uporabo
Il 1. poglavje Pregled
IIl. 1.1 Predstavitev laserskega sistema za graviranje in rezanje

Laserski sistem za graviranje in rezanje doseze ucinkovit nadzor z racunalnikom, to je
odvisno od razli¢nih pogojev dokonc¢anja obdelav. Sistem vklju€uje nadzorni racunalnik
in plosco, ki sta v pomoc¢ programski opremi. Ta priro¢nik opisuje uporabo programske
opreme za dokoncanje laserske obdelave (za Zicenje mati¢ne ploSCe in delovanje
nadzorne plosCe poglej prilozen prirocnik in navodila za upravljanje z zi€enjem
nadzorne plosce).

Programsko podprti datotecni formati:
Vektor format: dxf, ai, plt, dst, dsb... itd.
Bitmap format: bmp, jpg, gif, png, mng... itd.

I. 1.3 Zahteve okolja
e Windows 2K/XP/Vista, win7 XP priporocljiv
e Above CPU586, above PIIl in PV priporocljiva
e Spomin, priporo¢asenad 1 G

2. poglavje Nastavitev programske opreme
Nastavitveni koraki

Dvakrat klikni Setup.exe pod imenikom za nastavitev in pojavil se bo naslednje
okence:

Welcom to use (%13 F )

Install Iriwer/IE=hidE

Type /2R |Cnrel]]raw_La5 er ﬂ

Lanuage/iES |Engli sh ﬂ

[ Locate install path/TEfIZHERT

Inztall/32dE | ExitfiEH |

Klikni (nastavi gonilnik), da nastavis USB zagon:
Ce se pojavijo informacije o nastavitvi strojne opreme, izberi nadaljuj, dokler
nastavitev ni dokonc¢ana.



Hardware Installation

L] E The softveare you are installing far thiz hardware;
[

I1SB Serial Converter

has not pazzed Windows Logao testing to verify its compatibility
with "windaws =P, [Tell me why this testing iz impartant. |

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for zoftware that has
passed Windows Logo testing.

[ LContinue Anyway ] EéTDF'InstallatiDn |

Po nastavitvi se pojavi naslednje okence, ki kaze na uspesno nastavitev USB
gonilnikov.

L
\l‘) FTDI drivers have been install successfully installed!

Izberi vrsto in jezik, kot kaze spodnja slika:

Welcom to use (%8113 H )

Install Driver/3EzshEdE |

Type,/ZHEHl - |Laser'|'|'-:-r1': ﬂ
Lanuage/ &S |Eng1i sh ﬂ

[ Locate install path/TE{EHERRE

Exit/iEH |




Klikni nastavi. Po nastavitvi se pojavi naslednje okence s podatki o uspesni nastavitvi
programske opreme.

RLaser5etllp g|

\!j) Inistall Finish!

I1 3. poglavje Osnovno delovanje programske opreme
Delovanje glavnega vmesnika
Po zagonu programske opreme se vam na naslednji sliki prikaze vmesnik

Meniisk Sistemska Vrstica za rezanje
enijska vrstica

vrstica

Vrstica za

urejanje
e Nadzorna

A

plosca




Menijska vrstica: glavna funkcija te programske opreme je na voljo v menijski vrstici. Menijska
vrstica vsebuje dokument, popravi, narisi, nastavitev, obdelavo, pogled in pomoc.

Sistemska vrstica: v sistemski vrstici najdemo najpogostejse ukazne gumbe iz menija.

Vrstica za urejanje: privzeta vrstica urejanje je na levi strani delovnega obmocja. V vrstici
urejanje so namescena pogosto rabljena orodja, tako je delovanje bolj fleksibilno in prepricljivo.

Vrstica nastavitev: nastavitev izbranih objektov.

Nadzorna plos¢a: uporaba nadzorne plosc¢e za dokoncanje laserske obdelave veckratnih nalog,
nastavitev slojnih parametrov, nadzor osi, obdelovanje itd.

11.3.2 Nastavitev jezika in informacije o stroju

Poleg nastavitve jezika programske opreme lahko le tega zlahka spremenite.

Klikni v menijsko vrstici na pomo¢ (ang. [Help] ), nato izberi jezik (ang. &S Language] ,
tako da razsiris menijsko vrstico in izberi potrebne vrste jezikov.

Help (H)
About EDCAM )
| BS /Langusce NG L
EiEopir
English |

Other

Za pridobitev podatkov od proizvajalca, tako da vam lahko nudimo boljso storitev, Kliknite v
menijski vrstici na pomo¢ (ang. [Help] ), nato pana [About RDCAM] .

About [5_<|

Corp. Name: |

Tel:|

Addr: |

|
|
F:ax:| |
|
|

'|'|'eb:|

1)




II. 3.3 Nastavitev strani
Klikni na [Config] -> [Page setting] (slov. nastavitev strani) in pojavilo se bo
naslednje okence:

Page setting [5_<|

Fage widthi(mm):

Page height (mnm); |S00

Page home |Top left -

Cance

[Page width] : Sirina strani programske opreme, ponavadi je migljena §irina stroja X.

[Page height] : Dolzina strani programske opreme, ponavadi je misljena Sirina stroja Y.

[Page home] : Nicelnost strani programske opreme, ponavadi je misljena privzeta pozicija
stroja.

File(F) Edit(E) Draw@) Config@) Handlel] ¥iew() Help(i)
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I1. 3.4 Odpri datoteko in shrani

Programska oprema uporablja obliko zapisa rld, da shrani grafi¢ne podatke, spodnje
parametre razli¢nih slojev in obdelavo grafi¢nih elementov.

I1. 3.4.1 Odpri datoteko
V menijski vrsti klikni na »datoteko« in nato na »odpri« (ang. [File] -> [Open] ), nato na
ikono. Pojavilo se bo naslednje okence:

Look in: | @' Desktop “ O T £* [

E'lr'-’ly Documents Default,rld
' My Computer

HM‘;.# Metwork Places

[C)RDCAMSERUp ¥3.0.2

IC¥5endCommand

[Ctktt

File name: |Default.rld | [ Open l
Filez of tvpe: | *.1ld v| [ Cancel ]

[] Open as read-only

Izberi datoteko (na primer privzeto rld), klikni »odpri« (ang.[Open]))



[l. 3.4.2.Shrani datoteko

(1) V menijski vrstici klikni na »datoteko« in jo nato shrani, torej
> [Save] . Klikni na ikono I in pojavilo se bo naslednje okence.

Lu:u:ukjn:l@ Desktop v| O & B -

BM':.I' Dacuments

i My Computer

‘HM';.-' Metwark Places
ICIRDCAMSELUp ¥3.0.2
Iy SendCommand

[Ctktk

Input file name

File name: [ Defaultrid - | open |

Filez of twpe: |".r|u:| v| [ Cancel ]

[ 10pen as read-only

Vnesi ime datoteke v okence za urejanje in klikni »shrani« (ang. [Save] ).

II. 3.5 Uvazanje in izvazanje datoteke
Oblika zapisa datoteke za uvazanje: dxf, ai, plt, dst, dsb... itd.
Oblika zapisa datoteke za izvazanje: plt

[11. 3.5.1 Uvazanje datoteke

[File] -

Klikni na »datoteko« in nato na »uvoz« [File] -> [Import] . Zatem klikni na ikono ) .

Izberi datoteko in klikni »odpri« oziroma [Open] .



Import

Look i 9 FLT - -‘) ] -
I oooo03z.plt mE 4R ot S e
@957, plk G, plt I it
TR 7000, it O & T 1t = 5472 plt
I 9576, pt T A e U ELE ot
Ena0721.plt B plt
t a7 plt TR LRSS EE.
=t Airplane, plt B A, plt
TR Alphabet plt O EEL. plt
TR AP it 0 =, plt
@Beach.plt @EEE&E.DR
@an and Curve.plk @ﬂg.plt
U B plt O Bl 1. ot
@Business.plt @ B 223230l
O Circle. pit O #88-2.plt
HE|COMGER it I B plt
@Curva.plt @i‘fﬁfﬁiﬂ‘%‘plt

&) defaule.rd IR HE ph
@gemm.plt @’J\—'%.plt
i@ job 2.t T .
@shoelZ.plt @’Dﬁ.plt
T4 Rz it T 3 k- R plt

Preview

Filz name: Airplane. plt
Files of type: Supported Files1 w

Izberi [Preview] , izbrana datoteka se lahko prikaze. Za vecino vektorskih datotek
se podatki glede na opis plasti samodejno uvazajo v primerni del programske opreme
RDCAM. Za posebne dokumente, kot sta DST/DSB, se bodo podatki vnasali v trenutno
podlago.

Lok jri 3 DST v Q T @
shudie1,DST

LS045-,DST
L5066.05T
Lx215.05T
MIS0.DST
PORSCHEZ.DST
SUNFLOWR. DST
YERONIKA.DST

Freview

il e Ahudiel DST

Files of type: g w _Cancel
— | Trenutna Lo ]

podlaga

li HE NN = H




Il. 3.5.2 |zvazanje datoteke

V menijski vrstici klikni na datoteko, nato na izvoz in na ikono LH . Odpre se okno s
podatki o izvozu. Vnesi ime datoteke in klikni na »shrani« ali »save«.

Il. Nastavitev parametrov datoteke

Natan¢nost [Bll: glede na natanénost izvorne datoteke [l izberi primerno enoto za
uvoz.

Rahle krivulje: med uvazanjem vektorske datoteke samodejno poravnaj prvotne
krivulje. Kolikor zelite, da je originalni graf bolj raven oziroma obstaja potreba po
ponovnem uravnavanju rahlih krivulj, lahko to funkcijo odkljukate. Rahle krivulje lahko
zmanjSajo ¢as uvazanja.

Krivulje, ki se samodejno zapirajo.

Samodejni izbris ponovnih linij: samodejno odstrani povsem prekrivajoCe se krivulje.
Zdruzuj linije: glede na toleranco zdruzevanja so to samopovezujoce se krivulje.
Natancnost pri izvozu: natancnost pri izvazanju datoteke plt in izdatne datoteke.
Enota za hitrost: dve vrsti enote hitrosti mm/s, m/, podprti s programsko opremo.

File Parameter EI

Import Setting

FLT Frecizion: -
|:|Srnu:--:-th curwes
Emooth preeision(¥); |20

Autu:u rlose curwves
Close errorimm]: (0.1
ﬁ.utl:- delete repeat lines

Combine lines
0.1

Combine error (mm):

Export Setting:

Export Precision(%): 100

Velocity Unit: |3/ B0 infs. |-

conct

Osnovno grafi¢no oblikovanje
e Crta
V meniju klikni na »narii«, nato na »¢rta« (ang. [Draw] -> [Line]) , ), klikni »popravi

vrstico« 4 , povleci miSko in na zaslonu lahko nariSe$ kakrsno koli poljubno ¢rto.
Pritisni na tipko »ctrl«, medtem ko vlece§ misko in tako nariSe$ poljubno crto.



Veckratne Crte

V menijski vrstici klikni na »nariSi« in »veCkratne Crta«, nato na »popravi vrstico«.
Povleci misko na zaslonu, nariSe$ lahko poljubno veckratno crto.

Pravokotnik
V menijski vrstici klikni na »nari8i« in »pravokotnik« [Draw] -> [Polyline] in klikni na

»popravi vrstico« U . Na zaslonu povleci misko in nariSi pravokotnik v poljubni
velikosti. Pritisni »ctrl«, ko vle¢e$ misko.

Elipsa

V menijski vrstici klikni na »nariSi« in »elipso« in klikni na »popravi vrstico«
Povleci miSko na zaslonu in narises lahko elipso v poljubni velikosti.

Besedilo
V menijski vrstici klikni na »nariSi« in »besedilo« (ang. [Draw] -> [Text] ) in klikni

popravi vrstico A .

Dve vrsti zapisa za sestavljanje besedila, podprti s programsko opremo: pravi tip in
SHX.

@TI"IJ.ET}'PE Font: T i EF'jZ:AELlZ L'
4G Tont W pA0ll

Dvakrat zaporedno klikni na zaslon in pojavilo se bo naslednje okence:

Text §|

Text height (mm): i
Text diztance (mm): 0

Line distance (mm): |0

Text

Casce

Vnesi besedilo in ga nastavi, klikni tipko [OK]




. Izbira predmeta
Med samim procesom risanja in popravljanja grafik, se najprej mora izbrati predmet.

Ko se predmet izbere, le ta ima na sredini oblikovano oznako »x«. Obdaja jo osem
nadzornih tock.

V meniju klikni na »nariSi« in »izberi« (ang. [Draw )->[Select], ), klikni na

popravi vrstico [3 in preklopi na stanje . V tem stanju lahko izbereS predmet. V
nadaljevanju imamo pet vrst metod izbiranja:

eV menijski vrstici klikni na »popravi« in »izberi vse« (ang. [Edit] -> [Select All])
(bliznjica: Ctrl+A), izberi vse predmete. Klikni na miSko na zaslonu in izberi en

predmet:
| | |
J
| k4 |
oL,
| | |

Izberi predmet z uporabo okenca za izbiranje.

Klikni na misko in jo vleci vse dokler je okence z njo v stiku in predmet je izbran.
Povecaj izbiro predmeta, pomanjsaj izbiro predmeta.

Povecaj izbiro: pritisni »shift« in klikni »izberi« (ang. select), da povecas izbiro
predmeta.

Pomanjsaj izbiro: pritisni »shift«, klikni in okence izbere predmet.

Izberi predmet glede na podlago.

Layer Parameter

Layer Made  Speed Power Output

Cat 100,000 350000 Tes
Cat  100.000 30,000 Tes
Cat  100.000 30,000 Tes
Cat  100.000 30,000 Tes
Cat  100.000 30,000 Tes

Ip Down

Z desno stranjo miSke klikni na izbrano podlago, potem na vse dele predmetov in
izbrana je podlaga.

II. 3.8 Barva predmeta
Barva predmeta je barva konture predmeta. Kliknete lahko na barvo v vrstici za

podlago, da spremenite barvo izbranega predmeta. Tipka, ki pritisnete, ima barvo
trenutne podlage.



I1. 3.9 Preoblikovanje predmeta

Preoblikovanje predmeta v glavnem vkljucuje: lokacijo predmeta, orientacijo in velikost,
vendar ne spremeni osnovno obliko predmeta in njegove karakteristike.

I1. 3.9.1 Slika predmeta

Zavrti izbran predmet v vodoravni ali navpicni smeri. Klini na popravi vrstico A

in zavrti

izbran predmet v vodoravni smeri ™ . Zavrti izbran predmet navpicno.

I1. 3.9.2 Vrtenje predmeta

Klikni popravi vrstico O in pojavilo se bo okence o nastavitvi vrtljivega kota. Klikni na
[OK].

Eotate [5_(|

Rotate angle (deg)
cuce

Ce zelite povecati vrtljivost, nastavi vrtljiv kot na 0 in doloéi.

II. 3.9.3 Velikost predmeta

Izberi predmete in klikni »popravi vrstico« ™ in pojavi se okence o nastavitvi
velikosti.

Data S5ize [5_(|

o | [ | o

Cone

noa




Nastavite lahko velikost in srediS¢no to€ko izbranega predmeta. S kljukico lahko

zapres razmerje izbranega predmeta ﬂ

11.3.9.4 Razvrscanje podvojevanja predmeta

Klikni na »popravi vrstico« [3 in kopiraj izbran predmet. Nato klikni na B8 in pojavilo
se bo naslednje okence:

Hatrizx Copy

Fiece zize

345912 mim
T |eszo7 mm

Matriz Direction

@Top left OTop right

Frame Width(nm): (1200
i}

=

Frame Height imm):

¥ Distance (nm):
T Distance (mm):

D Distance between center

OBottom laft OBottom right

i

| Bectrewing breadth

bpply

D Center

Ok Cancel

¥ Sirina enega grafa (mm) I vigina enega grafa (mm)

Podvojene predmete lahko razvrstite v razliChe smeri. Smer kopije sloni na prvotnih
grafikah. Izberi pusCice, ki so obrnjene spodaj desno. Originalna grafika se bo pojavila
zgoraj levo, e so puscice obrnjene zgoraj levo, se originalni graf pojavi spodaj desno.
Po nastavitvi Stevila puscCic in nastavitve puscic, pritisni tipko

[Apply] .

Imamo dve obliki postavitve puscic: postavitev na sredino in na rob.
Izberi postavitev na sredino, nato klikni na razdaljo X (mm), razdaljo Y (mm), ki
predstavljata razdaljo obeh grafi¢nih centrov.

Ce ne izberemo postavitev puséic na sredino, potem kliknemo na [X
Distance(mm)], [Y Distance(mm)], ki predstavljata razdaljo grafinega roba.

Razdalja X od sredine: razdalja od roba X + Sirina objekta
Razdalja Y od sredine: razdalja od roba Y + dolzina objekta



Izbiraj med dvema metodama izraCunavanja. Razdalji X in Y bosta samodejno

izracunani.

Klikni na [Bestrewing breadth] . Programska oprema bo samodejno izracunala

Stevilko puscCice glede na velikost, Sirino, razdaljo X in Y.

Nastavitev je lahko neposredno vnos, nato klikni »uporabi« [Apply] .

Pritisnes lahko tudi smerokazne tipke, da nastavi$ predmete.

Preglej sredis¢e (ang. [Center]) in podvajanje puscic, grafike bodo osredoto¢ene
na delovno podrocje. Povleci kolo na miSki, da pomanjsas grafike. Povleci misko, tako

da bos videl grafike.

Hatriz Copy

Piece size
= 34591z mm

T |ese.o7 mm

Matrixz Direction
@Top left OTop right

OBottom left OBottom right

Frame Width(nm): |1200
Frame Height (mm): 00
¥ nom:
¥ mom:

¥ Distance (mm):

ol o w|| w

T Distance (nm):

D Distance between center

Bestrewing breadth

Apply

D Center

Ol Cancel

II. 3.9.5 Postavi predmet v prvotno stanje

Klikni na EE , izberi predmete, ki se morajo postaviti v prvotno stanje in nato klikni

11.3.10 Namestitev predmeta
Izberi predmete, klikni na orodja

O — mA L [
2SR 20 HaBDHE 4 hueeo:

2 & 0 oo

E .

za nastavitev

postavitev levo, postavitev desno, postavitev na vrhu, postavitev na dnu

mfh LA

rmn
SYosE Vertikalna, horizontalna postavitev, postavitev v srediScu.

H T Horizontalna enako dolga razdalja, vertikalna enako dolga razdalja




=0 e Enaka Sirina, enaka dolzina, enaka velikost

Merilni objekt:
Ce pritisnes tipko »shift«, izbiraj predmet en za drugim. Potem je merilni predmet
zadnji. Ce izberesS predmet, je merilni predmet predmet.

[1.3.11 Pogled na predmet
Pomakni: v menijski vrstici klikni na »uredi« in nato »pomakni« (ang. [Edit] ->

+
[Move] , ali klikni na “. Na podro¢ju risanja pritisni na levo tipko miske in povleci
svincnik.

Povecaj: v meniju najprej klikni na »uredi«, potem pa na »povecaj« (ang. [Edit]in -

> [ZoomOut], klikni na *. . Z vsakim klikom se podrocje risanja poveca za enkrat.
Povleci miSko na podrocje risanja in klikni. Z vsakim klikom in z miSko na sredini
podrocja risanja se to podroCje poveca za enkrat.

Pomanj$aj: v meniju najprej klikni »uredi«, nato »pomanj$aj« (ang. [Edit] -

> [Zoomin], alikliknina "\ Z vsakim klikom pomanjsaj podrocCje risanja za enkrat.
Povleci miSko na podrocje risanja in klikni. Z vsakim klikom in miSko na sredini
podrocja risanja se le to pomanjSa za enkrat.

Poglej/izberi: v meniju klikni na »uredi«, nato pa na »poglej in izberi« ali klikni na Gl

Povleci miSko na podrocCje risanja, pritisni na levo tipko miske in vleci. Na podrocju
risanja se bo pojavilo okence.

Pogled okvira strani: v menijski vrstici klikni na »uredi« in na »pogled okvira strani«

(ang. [Edit] -> View Page Frame]) ali klikni na ™ . Okvir strani se bo prikazal v
celoti.

Pogled podatkov: v menijski vrstici klikni na »uredi« in »pogled podatkov« [Edit}
>[View Data FrameRli klikni na **. Izbrani predmeti se bodo prikazali v celoti.

11.3.12 Pomembno orodje
Tukaj so najpogosteje uporabljena orodja. Uporaba teh pomembnih orodij lahko preuredi
trenutni dokument v grafikah in s tem je tudi obdelava rezultatov hitrejsa.

I1. Ro¢no nastavi vrstni red izrezovanja

Uporabniki lahko ro¢no nastavijo Stevilko izrezovanja vsakega predmeta. V menijski
vrstici klikni »uredi« in nato »prikazi smer« (ang. [Edit] -> [Show direction] ). Prav
tako klikni na »uredi« in »prikazi pot« (ang. [Edit] -> [Show path]). V sistemski

&= 17
vrstici klikni na . Delovno podrocje bo prikazalo pot in smer izrezovanja.
Crtkaste Crte pomenijo, da je laser izklopljen.



I;I
File(F) Edit (E) Draw () Config(3) Handle (f) View (¥) Help (H)

DwE @Al ea TRQBRA [+|He 0 N ~Vow[ Il mit 5

L R I L I T T

. Pn,

Stevilka
izrezovanja

=

CHE X | » 200NN &z

(==
=

I+ B8 4

Edmwfem+:=0 o HE EEE =

——— #Welcome to use the Laser system of cutting, Fropese the display area 10244765 or higher *——

Obdelava grafikov poteka po Crtkastih Crtah.

Vrstica za izrezovanje pokaze serijsko Stevilko izrezovanja trenutnega izbranega
predmeta. V kolikor spremenite serijsko Stevilko, se bo spremenilo tudi
zaporedje/vrstni red izrezovanja.

II. Ro¢no nastavi smer izrezovanja in zacetno toCko/izhodisCe
V menijski vrstici klikni na »uredi« in na »prikazi smer« (ang. [Edit] -> [Show

Direction] , v sistemski vrstici klikni na naslednjo ikono . Ta prikazuje smer
izrezovanja.
V meniju klikni na »uredi« in na »prikazi tocko« (ang. [Edit] -> [Show Point] , ). V

sistemski vrstici klikni na ikono * | ki prikazuje vse to¢ke izbranih grafik.

V meniju klikni na »uredi« in na »nastavi tocko izrezovanja« (ang. [Edit] -> [Set Cut

Point] ) oziroma v sistemski vrstici klikni na “w. Pritisni na »uredi toCko
izrezovanja«. Kot prikazujejo naslednji podatki je vozel, ki ga obdaja pusCica, toCka
izrezovanja. Dvakrat klikni na vsako tocko krivulje in toCka izrezovanja se namesti na
tocko.



V meniju klikni na »uredi« in »nastavi smer izrezovanja« [Edit] -> [Set Cut

B

Direction] oziroma v sistemski vrstici na ikono
izrezovanja.

Dvakrat kliknite na vozel, ki ga obdaja puscica in smer izrezovanja predmeta bo
obratna.

, S Cimer boste urejali smer

';I
File (F) Edit (E) Traw (D) Config(S) Handle () View (V) Help (H)
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Cutting point
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=ECH

[+ B8 4
|

ESnniwE~Z=0 DN B EE EETE ]

——— #Welcome to use the Laser system of cutting Fropose the display area 1024%TBE or higher #%-———

[I. 3.12.3 nastavljanje in urejanje vrezovalnih in izrezovalnih Crt
Risanje ali izvazanje krivulj. Krivulja je privzeta, ¢e nima vrezovalnih ali izrezovalnih
crt. Ce zelite dodati vrezovalne in izrezovalne Crte, izberi predmete, nato klikni

»uredi« in zatem »uredi vrezovanje« oziroma klikni na ikono o . Pojavi se naslednje
okence.



Cut in and out setting

Cut in
Enable
Line type: |Line b
Length (mm) : 3
With angle -
Angle (degrea): o
Cut aut
Ena]:-le
LineType: M bt
Length (mm] 3
ll:*:*::'Flemsanlle
N4l

conet

Da naredimo vrezovalne in izrezovalne Crte, moramo najprej omogociti funkcijo
vrezovanja in izrezovanja. Imamo dve vrsti vrezovalnih in izrezovalnih &rt: ravna Crta
in lok.

Ravno ¢rto naredimo na tri naCine:
a) vrezovanje s kotom: vrezovanje, pri cemer vstavimo izhodis¢ni segment v
doloCen kot, kot v nasprotni smeri urinega kazalca je pozitiven.
b) Vrezovanje na sredini: izhodis¢na toCka vrezovanja je sredina.
c) Vrezovanje iz sredine: smer vrezovanja poteka iz sredine proti izhodiS¢ni tocki,
dolzina je kot nastavitev.

Izrezovalna

Vrezovalna X




Dolzina izreza v loku je kot nastavljena. Obstajata dve vrsti vrezovanja in izrezovanja
v loku, kakor kazeta nasledniji sliki:

Zenska Moski
Nastavitev izrezovalnih Crt je enaka nastavitvi vrezovalnih Crt.

[1.3.12.4 Optimizacija poti
Optimizacija poti Ce primarno ponovno nastavimo vektorske grafike.

o
V meniju klikni na »roCaj« in na »optimiraj izrez« oziroma klikni na ®% in prikazalo se
bo naslednje okence:

3

Cutting optimize handle

Inzi de to outzide

Single inmer to outer -*
Dﬁ.rra}'
Height: (50 Dir: [Up to bo|»

canct

V meniju klikni na »uredi« in »pokazi pot« (ang. [Edit] -> [Show Path ) oziroma

[ ]
klikni na|11|. Pot izrezovanja lahko vidite pred in za obdelavo.



Pot izrezovanja grafikov se vedno zacne pri laserski glavi.

11.3.12.5 Glajenje krivulj
Da krivulje ne bi bile tako ostre, lahko na podlagi te funkcije gladimo krivulje in s tem

tudi obdelavo.
V meniju kliknite na »rocCico kontrolnika« in na »glajenje krivulje« ali kliknite na ~
Pojavilo se bo naslednje okence.

Curves smooth E'

FullFrame Cancel

[

Smoothness




Vlecite drsnik za glajenje invkliknite na gumb »uporabi« (ang. [Apply]) pred in za
prikazom krivulj v okencu. Crne krivulje predstavljajo prvotne krivulje in rdece
predstavljajo gladke krivulje.

Curves smooth &l
Smoothness - J 30% Apply
FullFrame Cancel

Grafike si lahko ogledate, tako da vleCete miSko. PomanjSate oziroma povecate jih
lahko s kolesom miSke. Kliknite na gumb »celotni okvir« in v okencu se bodo pojavile
grafike.

Po uspe$nem ucinku glajenja kliknite na »uporabi« (ang. [Apply) in krivulje se bodo
glede na nastavitve glajenja gladile.

11.3.12.6 Preglej zapiranje krivulje
V meniju klikni na »rocico kontrolnika« in »samodejno zapri krivuljo« (ang.

[Handle] -> [Curve auto close], ) oziroma v sistemski vrstici klikni na [Tin
pojavilo se bo naslednje okence.

S5etting close error [5_<|

Close error (mm):

Fu:uru:e to close

canct




Odpravi napako. Ce je razdalja od izhodi$éne tocke do konéne tocke manjsa,
samodejno zapri krivuljo.

Setting close error §|

Close error (mm):

Fu:-ru:e to close

cancal

Sila, ki je preblizu: obvezno zapri vse izbrane krivulje.
[1.3.12.7 Odpravi prekrivanje
V meniju klikni na »ro€ico kontrolnika« in »zbriSi preskok« oziroma klikni na

= . Programska oprema bo samodejno odstranila krivulje, ki se pokrivajo, znotraj
izbranih krivulj. Obstajata dva dela funkcije, da odpravimo prekrivanje. Razbij krivuljo

na Stevilne dele, da krivulja pokriva sama sebe.

Samodejno preveri krivulje, ki se povsem pokrivajo in jih poskusi opraviti.

Check ovelapping lines

Cwelapping lines exist, delete or not!

11.3.12.8 Kombiniraj krivuljo
V meniju klikni na »ro€ico kontrolnika« in na »kombiniraj krivuljo« oziroma klikni na
et . Pojavilo se bo naslednje okence:

Setting combine error §|

Combine error (mm):
e

Programska oprema samodejno zdruzuje krivulje v izbrane krivulje. Ko te krivulje
zdruzujejo toleranco, je to manj kot nastavitev kombinirane napake.




[1.3.12.9 Bitna rocica

Klikni na [:3 , izberi bitno mapo in v meniju klikni na »kontrolnik roCice« in nato na

»bitno rogico« (ang. [Handle] -> [Bitmap handle] ) ali pa klikni ** v sistemski
rocici.

Bitmap handle
.- Pixels 15  Pixels
Pixels 2048 Pixels
Pixels/inch 99 Pixels/inch
Pixels/inch 89 Pixels/inch
Brightnes: a—u
9] Zero
0.0%
Contrast: o !
J | Zero |
0.0%

|:| Invert color

Resolution(pixels/inch)

Resolution (pixels/inch) |gg

[ Dither
Het graphic
Frequency [lines/inch) 1
Dot graphic
Black And White
Gray scals
Apply to view H Apply to source ‘
[ I |
Save as ‘;;FullScreen‘| Ok h Cancel ‘
i i

Zgoraj desno se pojavi okence s podatki o trenutni sliki. Bodite obvesc¢eni o tem, da

se horizontalna in vertikalna locljivost spreminjata z lestvico.

Uporabi in preglej (ang. [Apply to view]) : trenutne nastavitve se uporabljalo le za

predogled, brez tega, da bi vplivali na originalno bitho mapo. Pritisni na gumb
[cancel] ali »prekini« in bitna mapa se bo povrnila v stanje prvotne slike.

Uporabljaj ga samo za to, da prilagodi$ ucinek. Ta pristop zahteva vec €asa in tudi
spominskega prostora.

Uporabi, da odkrije$ [Apply to source] : trenutne nastavitve se uporabljajo samo za
prvotno bitho mapo, tako da v vsakem primeru kliknite na gumb.

Prekli¢i [Cancel) in slika se ne bo mogla vmiti v prvotno stanje. Zato v glavhem gre
za postopek z vec koraki. Ta korak je treba izvesti. ObiCajne slike se morajo pretvoriti
v sivino. To nam prihrani ¢as pri delu z raCunalnikom, zlasti pri sledeem postopku.
Shrani kot ali ang. [Save as] : Pridobi rezultate prejSnjega postopka. Poleg funkcije
»uporabi in poglej« obstaja tudi funkcija izvazanja. S tem lahko olajSate sledeco
obdelavo.

»Sivina« obdelava drugih slik ponavadi temelji na sivini. Preden kakor koli ravnate
lahko obdelate slike v sivini in kliknete gumb [Apply to source] . Obdelava drugih
slik temelji na sivini. Preden ravnate, jih lahko obdelate v sivini, nato klikni na [Apply
to source] . Za sivino v primerjavi z barvno sliko upurabljajte malo spomina, za veéje
slike ravnajte korak za korakom. Do doloCene mere se izogibajte pomanjkanju
spomina.



Za barvno sliko uravnavajte kontrast in svetlobo, pomagajte si s tresljaji.

Uravnavajte kontrast

074202020

074102009

Po obdelavi

Preobrazba:

g
=
a
g
5

Imamo tri metode za tresljaje: grafika net, grafika dot, ¢rno in belo.

1 Mrezna Grafika

Za mrezno grafiko moramo uravnavati velikost mreze, to pa bolje ustreza materialu,
ki nima velike lo€ljivosti ali pa je laser relativnho prepocCasen, da se odzove. Da boste
dobili Zeleno mrezno velikost, lahko uravnavate locljivost in mrezno frekvenco slike.
Cim visja je logljivost, tem vegja je obéutljivost. Z ve&jo mrezno frekvenco se manj$a
velikost mreze. Manj$a je mrezna frekvenca, vecja je velikost mreze. Obicajno je
locljivost slike 1000 in mrezna frekvenca ima od 30 do 40 ¢rt.
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Il 4. poglavje Sistemske nastavitve
Pred rezultati grafik je potrebno dolociti, ali so nastavitve sistema pravilne. V meniju
klikni na »konfiguriraj«, nato na »nastavitve sistema« ali (ang. [Config] —> [System

Setting]) ).

Config(3)| Handle(f)  Vie

Swstem Setting |

File Fara Setting

Fage Setting
Password Setting

Graph Hateh

II. 4.1 Izvoz laserja

Laser export |General settings | Machine para | Document | System Info

Srarming (Rewerse interwal)

Feeding Count: Spead (mmi =) Reverse ...
Tistance (mm):
Omo_gogl Frolumn setup
hranjenje T Fum: |1 T Fum: |1
¥ezpace (mm): [0 Yepace (mm): |0

|:| Enable center distance

Bestrewing breadth. ..

< >
DEnable rotate engrave
_ Add. .. Del
Diameter (mm):
Step per rotate (pulsel: — (O I 0

Nastavitev hranjenja

Za polnjenje morate najprej omogociti polnitev. Potem ko so polnitveni parametri
nastavljeni, bo jasek polnil polnitveno dolzino. Ponovite ta proces, dokler ¢as
obravnave ne doseze Stevilo polnitve.

Nastavitev puscic

Nastavitev puscic poenostavlja in olajSa obravnavo puscic v grafikah.

Stevilka X in Y ustrezata vrsticam in stolpcem pudéic. Mesto x in y ustrezata
names&enju pusdéic v vrstice in stolpce. Ce ni odkljukano, omogoéi »razdaljo od
sredine«, namescCanje x in y pomenita namescanje po robu, drugaCe pa to pomeni
namescanje na sredini.



Nastavitev Sirine:

Glede na velikost okvira in trenutne nastavitve puscic doloCimo najvecCje mozno
Stevilo stolpcev (Stevilo x) in vrstic (Stevilo y).

Pritisnite na gumb nastavitev Sirine (ang. bestrewing breadth) in pojavilo se bo
naslednje okence.

Bestrewing breadth §|

¥ breadth (um):

¥ braddth(mm): (300

Klikni OK in programska oprema bo samodejno izraCunala ustrezno Stevilo vrstic in
stolpcev.

Zasuk vrezovanja

Omogoci zasuk vrezovanja

Omogoci zasuk vrezovanja [Enable rotate engrave] :Potem ko smo omogodili
vrezovanje, je dejanska natancnost osi y odvisna od premera in koraka glede na
zasuk, da ta samodejno ustreza nastavitvi natan¢nosti pulza osi y. Poleg tega se bo
delovno podrocje v glavhem vmesniku tudi spremenilo.

Premer [Diameter] : velikost premera delov
Korak na zasuk [Step per rotate] : Stevilo pulza ustreza enkratnemu zasuku dela

Obrni interval

Medtem ko je skeniranje dvosmerno, lahko napetost pasu povzro€i rob grafi¢ne
nepravilnosti. Da to spremeniS, nastavi mrtvi tek. DoloCena hitrost ustreza
specificnemu mrtvemu teku. Cim vecja je hitrost, tem vedji je mrtvi tek.

Dodaj nastavitev mrtvega teka
Klikni na gumb »dodaj« Add in pojavilo se bo naslednje okence.

3

S
Beverse interwal (mm) ICI

cancl

Po nastavitvi hitrosti in obracanju intervala klikni na OK in vrednost mrtvega teka se
vnese v seznam mrtvega teka.




Spremeni nastavitev mrtvega teka
Dvakrat klikni na to¢ko v seznamu mrtvega teka in pojavilo se bo naslednje okence.

%]

Speed (mmfs) |0

Beverse interwal (mm)

Cancel

Odpravi nastavitev mrtvega teka

Klikni, da izberes$ tocko, ki jo zeli$ izbrisati in klikni na »izbriSi« ali »delete«.

Il. SploSna nastavitev

Settaing

Laser export | Feneral settings |Mar_'hine para || Docuament | Swstem Info
baris Mirrar Laser head
O O o Joint Frecision (0-Zmm): ICI
O O O Run Repay (0—3mm): [ I:I
ﬁ.xis T Mirror 0O O o0
Cutting space Repay
Small eirele =peed limit DEnable cut backlash repay
Radiuz (mm) Speedimm/ =) i 8
Repay: o o
Space (mm): |0 0
I:lCutting lazer on—off repay
LaserOn  Laser0ff
< | Bepay (mml: | || |
Add. . Delete Brergy(®): |1 |
Zrcalo osi

Obicajno je smer osi zrcala odvisna od dejanske lokacije meje ali privzetosti stroja.
Privzeti sistem koordinat, ¢e Descartes koordinira sistem in ni¢la spodaj levo. Ce je
ni¢la stroja zgoraj levo, potem os x ne odbija, os y pa mora odbijati.

Ce je ni¢la stroja zgoraj desno, potem obe osi, tako x kot y, morata odbijati. Poleg tega
se ta funkcija lahko uporabi za drug aplikacijo za zrcalo.



Glava laserja
Polozaj glave laserja pomeni, da je lokacija laserske glave sorazmerna z grafiko.

|
9202
o)e 710 ole

Zgoraj levo Zgoraj na sredini  Zgoraj desno

éziﬂ (Ezﬂ )
o g o B ) ) £ i

N |
Na sredini levo V srediS¢u Na sredini desno

28 W 2 W

1% 00 a0
| Spodaj desno

Spodaj levo Spodaj na sredini

Skupna to¢nost (od 0 do 2 mm)

Ko meri razdalja med kon¢no toc¢ko ene Crte in kon¢no ¢rto druge ¢rte manj kot
skupna to¢nost, potem programska oprema samodejno poveze ti dve Crti.

Opozorilo: ta vrednost se ponavadi nastavi 0,1 mm za velike koli¢ine grafi¢nih
podatkov, da se zmanjSa Cakalni ¢as pred obdelavo na 0 mm.



Zazeni repay .
Da bi skok bil hitrejsi, lahko pride do napake. Ce zazenemo repay, lahko to
nadomestimo.

Majhen krog omejitev hitrosti
Pri obdelavi dela doloCi programska oprema samodejno, ali trenutni krog mora omejiti
hitrost. Nato se glede na velikost premera kroga dolo i hitrost.

Ce je konfiguracija parametrov ustrezna, bo to zelo poveéalo kakovost majhnega
kroga. Klikni na »dodaj« in »zbriSi« ter konfiguriraj.

Programska oprema bo samodejno izraCunala hitrost kroga glede na seznam
omejitve hitrosti kroga.

Rezalni laser on-off repay
Potem ko omogocimo funkcijo »cutting laser on-off repay«, programska oprema
glede na nastavitve on-off repay samodejno reze.

Repay: vklopljen laser, kako se laserska energija postopa spreminja iz zaCetne do
normalne energije, medtem ko se stroj od zaCetne tocke pomakne za repay dolzino.
Izklopljen laser, stroj se od koncne tocke pomakne za repay dolzino.

Energija (ang. [Energy] ): energija zacetne tocke grafikov.

11.4.3 Stro'ini parametri

Laser export | Gemeral settings | Machine para |Document | Svstem Infa

Bl Cut parameters | | [2] Axis parameters -
Idle speed(mmis] 200. 000 huis X
Idle Accimmfs2) 3000, 000 Direction polarity Hegatiwe
Start speedimmfs) 20,000 Limiter polarity Hegatiwe
Min Ao (nmés2) 400. 000 Contrl Mode Fulzetlir
Max Ace (mmi=2) 3000. 000 Eeving direction  Hegatiwe
Cutting mode Hormal Cutt Step length(um) 0. 350
hee Mode 2 mode Max spead (umfs) 1000. 000

E Sweep parameters Jump—off speed(ums 5. 000
x¥ Start Speedimm/= 10,000 Aoeceleration (mmdsZ2 8000, 000
¥ Start Speedimm/=z 10,000 L¥S Breadth (mm) 1000, ooa W

Open Read

Sledi opis parametrov stroja:
A. laserski parametri
a) Laserski nacin: imamo tri vrste laserskih naprav: domaca steklena cev, RF
laser (prezgoden pulz ni pogoj) in RF laser (prezgoden pulz je pogoj), steklene
cevi sprejmejo analogno koli¢ino za nadzor, RF cevi sprejmejo digitalno



koli¢ino za nadzor. Ce stroj sprejme domaco stekleno cev, je vrsta laserja
»analogna koli€ina«, €e pa sprejme RF cev, se razmerje izbere temu primerno
(prezgoden pulz je pogoj//ni pogoj). Po spreminjanju opcij vrst laserja, naj bi se
sistem ponovno zagnal in spremembe naj bi bile po ponovnem zagonu
u€inkovite.

b) Laserska frekvenca: frekvenca pulza nadzornega signala, ki jo uporablja
laser, namescen na stroju.

c) Maksimalna moc (%), minimalna mo€ (%): za laser lahko nastaviS omejitvene
vrednosti moci, in sicer med delovanjem, maksimalna moc¢, ki jo nastavi
uporabnik ne sme biti viSja od maksimalne moci, ki je nastavljena tukaj, in
minimalna moc, Ki jo nastavi uporabnik, ne sme biti nizja od minimalne moci, ki
je nastavljena tukaj.

d) Zastoj ob vklopljenem oziroma izklopljenem stroju: Ce zastojni parameter ob
vklopu in izklopu ne kaze 0, se laser vklopi ze vnaprej in se izklopi po zastoju,
ki je bil nastavljena vnaprej. Casovna zamuda zna$a od 0 do 0.1 sekund.

Drugi parametri

Ponovno nastavi hitrost: ta parameter sluzi vrnitvi hitrosti stroja v prvotno stanje, ko
se le ta zazene. Ce je stroj presirok, lahko nastavi primerljivo vrednost ponovne
nastavitve hitrosti. Hitrost ne sme biti nastavljena previsoko, kontrolnik nadzoruje ta
parameter znotraj 50 mm/s. Vsakrdna ponovna nastavitev hitrosti s strani uporabnika,
ki presega 50 mm/s, naj se smatra kot neveljavna.

Hitrost ob mirovanju

Ta parameter doloCa maksimalno hitrost vseh Crt, ki ne oddajajo zarkov med
delovanjem stroja. Ta parameter naj ne bi bil nizji od odskoc¢ne hitrosti osi x in osi y.
Parameter ne sme presegati maksimalno hitrost osi x in osi y, €e je nastavitev
nedovoljena, kontrolnik samodejno nastavi parameter znotraj zgoraj omenjene
omejitve. Primerljivo visoka hitrost ob mirovanju lahko skrajSa Cas delovanja.
Prekomerna visoka hitrost mirovanja lahko povzroCi tresenje poti, zato morate ob
nastavitvi upostevati vse ustrezne faktorje.

Hitrost Citanja s premikom Crte

Ta parameter se posebej uporablja za nadzor maksimalne hitrosti Citanja z vertikalnim
premikom z ene érte na drugo. Ce je med &itanjem veliko prostora med vrsticami
oziroma je prostor oviranja velik, lahko nastavite hitrost Citanja s premikom med
vrsticami na primerljivo nizjo vrednost. Ta parameter ne sme biti manj kotodskocna
hitrost ustrezne osi med premikom med vrsticami in ne sme biti viSja od maksimalne
hitrosti ustrezne osi med premikom med vrsticami. Ce je nastavitev nedovoljena, bo
kontrolnik samodejno nastavil ta parameter znotraj zgoraj omenjene omejitve.

Pospesitev:

Ta parameter doloCa pospeSitev in zaviranje (stanje S ali stanje T) motorja med
delovanjem. Motor pospeSuje ali zavira pocasneje in rahlo v stanju S, medtem ko v
stanju T je to sorazmerno hitro in ostro. Privzeto stanje je stanje S.

Citanje: Na izbiro sta dva na¢ina: obi¢ajni nacin in posebni nacin. V obi¢ajnem naéinu
ni delovanja med Citanjem. V posebnem nacinu gre za delovanje svetlobnih mest. Ce
se aktivira posebni nacin, se pove€a mocC laserja in s tem se tudi zniza odstotek



svetlobnih mest in moc laserja. Da dosezemo isti u€inek Citanja, mora biti laserska mo¢
viSja. Namen posebnega nacina je da laser oddaja zarke zelo mocno in v kratkem €asu
med citanjem. DoseZzemo lahko udinek ravnina/dno. Ce pa svetlobna mesta niso
pravilno uravnavana, ne moremo doseci tega ucinka. Nacin delovanja ob vecji moci in
v kratkem Casovnem razmiku lahko vpliva na vzdrZzevanje laserja. Privzeti nacin je
obicajni nacin.

Facula velikost: ta parameter je neveljaven v obi¢ajnem nacinu Citanja. Ta parameter
velja samo za posebni nacin. Verjetnost nadziranja parametra s strani kontrolnika je
od 50% do 99%.

Nacin razporeditve (puscic): izbiras lahko med nihalnim nainom in enosmernim
nacinom. Pri nihalnem nacinu rezemo puscico po vrsti naprej in nazaj. Pri enosmernem
nadinu rezemo puséico z ene smeri na drugo. Ce izberemo enosmerni naéin imajo vse
puscCice isti nacin gibanja in tekoCe gibe. Kljub temu bo ta nacin terjal ve¢ ¢asa od
nihalnega nacina. Privzeti nacin je nacin nihanja.

Mesto vrnitve: izberete lahko lokacijo in izvor stroja. Ta parameter doloCa mesto,
lokacijo ali izvor stroja, kjer se glava laserja ustavi po vsakem delovaniju.

ZascCita

Ce ima stroj dodatne za3¢itne signale poleg zas¢ite vode, v tej opciji lahko izbirate.
Vnos zascitnega signala se je opravil iz univerzalnega mesta 2 (prosim, glej v navodila
za uporabo za glavni racunalnik). Ko omogocimo ta zas¢itni signal, kontrolnik izvede
pregled zascitnega signala v realnem casu, €e je vnos na visokem nivoju, je stroj
zasciten in delovanje se prekine, laser pa se izklopi.

Parametri osi

Ce se os x in y pomikata proti izvoru stroja, ko se elektriéni sistem stroja ponovno
zazene, to pomeni, da je polarnost smernega signala osi nepravilna. V tem €asu lahko
odklopite os od motornega zagona (drugaCe je pregled glavnega racunalnika
nezadosten, to lahko povzro€i kolizijo osi). Potem ko D16 na glavhem racunalniku
utripa (kar pomeni, da je raCunalnik bil ponovno zagnan, D16 izide prvi, vsaki¢ ko
ponovno zazenemo stroj in zacne utripati po zagonu. Ne berite in ne piSite vseh
parametrov na racunalniku, preden D 16 zacne utripati; prosim, glej v navodila za
uporabo za raCunalnik za mesto D16. Spremeni polarnost smernega signala osi na
racunalniku in potem ponovno zazeni racunalnik.

Omejevalnik polarnosti: Ko os gibanja doseze mejo, se sprozi signal na nizki ravni in
vklopi svetlobno diodo, ki ustreza razliénim mejam. Ce se os gibanja odmika od meje,
se sprozi signal na visoki ravni in izklopijo se svetlobne diode, ki ustrezajo razlicnim
mejam, mejna polarnost je negativna. Drugace je, Ce se os gibanja odmika od meje.
Takrat so svetlobne diode, ki ustrezajo razlicnim mejam, zunaj in ko os gibanja doseze
to mejo, so svetlobne diode, ki ustrezajo razlicnim mejam, vklopljene. Mejna polarnost
je pozitivna. Nepravilna nastavitev mejne polarnosti lahko povzro€i nezadosten
pregled sistema med ponovnim zagonom, kar lahko vodi do kolizije osi.

Kontrolni nacin: na voljo sta dva nacina: na€in dvojnega pulza in pulz + smerni nacin,
ki naj bosta odstranjena glede na vrsto motornega zagona, ki je namescen na stroju,



obicajno se izbere nacin pulz + smer. Po kakrsni koli spremembi opcije naCinakontrola,
naj bi se racunalnik ponovno zagnal in sprememba bi bila ucinkovita.

Tipkovna smer: po pravilni nastavitvi smerne polarnosti stroja se os X pomakne desno,
ko pritisnete na levi gumb. Ko pritisnete na desni gumb, se os X pomakne levo. To
pomeni, da so tipkovne nastavitve smeri nepravilne in spremembe naj bi se temu
ustrezno uvedle. Tipki gor in dol ustrezata gibanju osi y. Ce se os y pomakne navzgor,
ko pritisneS gumb »navzdol« in se os y pomakne navzdol, ko pritisnes tipko gor, bi se
morale tipkovne smeri 0si y spremeniti.

Dolzina v koraku: ali pulzna ekvivalenta motorja, to pomeni absolutno distanco, ki jo
pokriva ustrezna os, ko pulz potuje motorju. Pred pravilno nastavitvijo vrednosti, lahko
stroj pripravite do tega, da izreze veliki pravokotnik (vecCja je slika, manj je napak) in
dolzino motorja lahko izraCunamo samodejno z dolzino slike in izmerjeno dolzino.

Maksimalna hitrost: gonilna sila motorja in inercija osi gibanja doloca maksimalno
hitrost polarnosti osi. Med Citanjem naj Citalna hitrost ne bi prekoracila maksimalno
hitrost, ki ustreza osi Citanja. V naCinu rezanja posledicna hitrost med rezanjem ne sme
prekoraciti najnizjo maksimalno hitrost osi X in osi Y. Ce je hitrost nastavljena
previsoko, kontrolnik samodejno varuje maksimalno hitrost.

Odskoéna hitrost: hitrost osi gibanja se zacne Ze v staticnem stanju. Ce je nastavljena
previsoko, lahko motor izgubi soasnost, se zaéne tresti ali pa Zvizgati. Ce je prenizka,
se hitrost delovanja celotne figure zmanjSa. Glede na inercijo osi gibanja, lahko to
vrednost nastavimo na 8 do 15 mm/s. Ce je inercija osi gibanja previsoka (oziroma je
os pretezka), lahko nastavi$ nizjo odskoéno hitrost. Ce pa inercija osi gibanja prenizka
(os je prelahka), lahko nastavi$ viSjo odskoc¢no hitrost.

PospesSitev: pospeSitev osi gibanja, ko pospeSujemo ali zaviramo, previsoka
pospeSitev bo povzroc€ila izgubo soCasnosti, tresenje ali zvizganje motorja, medtem
ko zaradi prenizke pospeSitve pride do poCasnega pospesevanja, kar bo zmanjsalo
hitrost delovanja. Tipiéen obseg od 800 do 3000 mm/s? lahko nastavimo za os z
veliko inercijo. Os Y ustreza ogrodju, npr. tipi¢ni obseg znasa od 10000 do 20000
mm/s2. Ta se lahko nastavi za os z nizko inercijo. Os X ustreza na primer lutki.

Sirina: maksimalna razdalja, ki jo lahko os gibanja pokrije, se doloéi glede na dejansko
stanje stroja.



[1.4.4 Dokument

setting

Laser export | General settings |Machine para| Decument |Syctem Info

Document

Humber File Hame

Deleate Delete ALl
Read Download Froceszs

Beri

Klikni na gumb »beri«, programska oprema bo komunicirala s kontrolnikom, beri
seznam dokumentov na kontrolniku.

Po uspeSnem branju kontrolnika, se bodo prikazali datote¢ni podatki na seznamu
dokumenta.

Prenesi

Klikni na »prenesi« in prikazalo se bo okence. Izberi preneseno datoteko rd in datoteka
se bo prenesla na kontrolnik. Ce je prenos uspeden, se dokument posodobi.

Proces

Izberi datoteko iz seznama dokumentov in klikni na gumb »proces«. Kontrolnik bo
obravnaval oznacen dokument.

Zbrisi

Izberi dokument, ki ga Zeli§ izbrisati iz seznama dokumentov in klikni na gumb
»zbridi«. Kontrolnik bo zbrisal oznagen dokument. Ce je izbris uspesen, bo dokument
posodobljen.

ZbriSi vse

Samodejno odstrani vse datoteke v kontrolniku in posodobi seznam dokumentov.



Sistemske informacije

setting

Laser export | General settings | Machine para | Document | System Info

Total on time (hour: min:s):

Total processing time (hour min:s):
Frevious processing time (hour:min:s:ms):
Total laser on time (hour:min:=):

Total processing times:

¥ Total trawal (ml:

T Total trawel (ml:

Mainboard wersion:

Skupni €as: skupni ¢as raCunalnika

Skupni ¢as obdelave: skupni ¢as obdelave, vklju¢no s ¢asom skoka

Prej$nji ¢as obdelave: Cas zadnje obdelave

Skupni laser: ¢as obdelave laserja

Skupna obdelava: Stevilo dokon&anih obdelav, ne vklju€ujejo obdelave do konca
Skupno potovanje X: skupno potovanje motorja X

Skupno potovanje Y: skupno potovanje motorja Y

Maticna verzija: verzija sedanjega kontrolnika

[1.4.6 Nastavitev gesla
:unfig[ﬁ:q Handle (] Vi

System Setting
File Fara Setting

Fage Setting

Fassword Setting |

Graph Hatch

Tovarna lahko uporablja funkcijo nastavitve gesla za nastavitev gesla proizvajalca ali
obCasnega gesla upravljalca.

Klikni na nastavitev gesla. Ce je povezan s kontrolnikom, se bo pojavilo naslednje
okence:



Input ¥endor Password r')_(|

Vendor Password: |:|

[ o | [ Cancel ]

Po vnosu pravilnega gesla proizvajalca, se bo prikazalo naslednje okence:

[ Yendor Fassword l

I Feriod Fassword ]

Nastavitev prodajalCevega gesla

¥Yendor Password S5etting [$_<|

01d Password: » 1. Vnesi staro geslo

Hew Paszword:

2. Vnesi novo

Confirm

3. Potrdi novo geslo

Modi £

i

4. Spremeni geslo

Kot kazejo slike, vnesi staro in novo geslo, potrdi ga in klikni na »spremeni«.

LaserWork [')_<|

! "_q,, Password modified success!




Obcasno geslo

Period Password Setting ['5—<

/
Humber of Periods
Vendor Paszword: ———>
Feriod Interwal:

[¥ariable Period Setting. .. || | |

1. Stevilo obdobij

2.Vnos

3. Vnhos obc¢asnega

4. Nastavi obdobje

| ’Save Paszwor d]
el

| Cancel

A

5. Shrani geslo

Po nastavitvi obdobja, oznaci kateri dan???
Klikni na »shrani geslo« in pojavilo se bo okence, da se shrani geslo.

Save as... E]
Save jn |@ Diesktop v‘ Q & E°E-
ﬂMy Documents

:J My Computer

%My Metwork Places
[CIRDCAMSELp ¥3.0.2
|25 SendCommand
[tk

[Z] debugcommand. bxt

File name:

| s

Save as bwpe: | bt

Cancel ]

¥ |

Po uspesni shranitvi gesla se pojavi naslednje okence:
LaserWork E'

! E Create Password Success!
L




Podatki datoteke z geslom

[

Prvo

File

password.txt - Motepad
Edit Format Wiew Help

Geslo 1. obdobja

Stevilo dneva 1. obdobja

Geslo za preklic

Ce se programska oprema zaklene, lahko vnese$ ustrezno geslo za trenutno
obdobje oziroma vneses geslo za preklic. Po vnosu gesla za preklic kontrolnik ne bo

veC omejeval.

Spremenljivo obdobje

Ce ze morate nastaviti spremenljiv dan za vsako obdobje, preverite spremenljivo

obdobje.

Period Password Setting

Humber of Feriods
Yendor Faz=sword:

Feriod Interwal:

[#] ¥ariable Feriod

Aok

'

’ Cancel ] ’Save FPaz=word

X




Preverite spremenljivo obdobje in kliknite na nastavitev.

Period day setting rs_(|
Period HO Period Inte. ..
1 1
a [3
< I

Po uspesni nastavitvi zaprite okence in shranite geslo.



Il. 5. poglavje Obdelava

Device

. . ayer Parameter
iskanje

Layer Made Spead Fower (Output

Nastavitve podlag [«

Find Com Auta -

g Down

Lazer work

Fosition: Current positio| -

o scale Cut scale
Start Fanse/Continue Stop
Nadzor obdelave < SaveToiifile UFileOutput  |Download

DDutput select graphics
Path optimize

Current Fosition

SN

i
T
Z

Previous worlt time | |OH:OM:0S:0MS

bxiz Mowve
Offset (un): 10
Nadzor osi e — ¥ | Spesd(um/s): |50
i- it Fower (%]: |0
T 7 DMDV& from origzin

[ ]If Light

[1.5.1 Iskalna naprava
Ce se je raCunalnik povezal samo z eno napravo, lahko preklopite na
samodejno funkcijo. Programska oprema bo avtomati¢no iskala napravo.

Ce se je raéunalnik povezal z mnogimi napravami, potem morate najprej
klikniti na [Find com] . Po iskanju prispevajo povezane naprave seznamu padcev.
Kar morate storiti, je da izberete ozna¢eno napravo.



Nastavitev podlog

Layer Parameter

Is Dutput:  CCCHNNNNE ~

Speed (mm/s): 100

|

Min Fower (%) |30

Max Power (31: |30
If BElowing: Yas \

Procezzing Mode: Cut -
Seal (0-Smm): [0
Open Delay(m=): |0
Close Delayims): [0
Ok Cancel

Imamo dve opciji: da in ne. Ce izbere$ da, p

Imamo dve opciji: da in ne. Ce izbere$ da, pride do
izvoza zadevne podlage; Ce pa izbereS ne, ne pride
do izvoza.

Hitrost obdelave laserja: hitrost bo vplivala na
ucinek obdelave: manj$a je hitrost, boljsi je u€inek
obdelave in lazja je pot. Vi§ja je hitrost, slabsi je
ucinek obdelave. Ce je vrednost hitrosti nig,
pomeni, da smo uporabili privzeto hitrost (hitrost,
ki je nastavljena na ploSCi stroja). Prosim, vnesi
ustrezno vrednost hitrosti.

¥K

Vrednost moci je lahko od 0 do 100. to pomeni
intenzivnost laserja med obdelavo. Vi§ja je
vrednost, mo¢nejsi je laser. Ce je pa vrednost
modi, je laser Sibkejsi. Ce je vrednost 0, to pomeni,
da se uporablja privzeta mo€. (mo€ je nameScena
na plosc¢i stroja).

N

Nacin obdelave- nacin, kako obdelati zadevno
podlago; Ce izberete vektorsko podlago (barvno
podlago), imate tri opcije: Citanje z laserjem,
rezanje z laserjem in pikanje z laserjem; Kolikor
izberete bitno podlago, imate samo eno opcijo:
Citanje z laserjem.

Kako nastaviti pravilno minimalno moc¢ in maksimalno moc¢
Ce je laser premocen med celotnim procesom, nastavi minimalno in maksimalno moc¢

nizje, drugace pa visje.

Ce je laser na nekaterih mestih preslab med procesom, nastavi maksimalno moc

vigje.

Ce je laser na nekaterih mestih premo&en med procesom, nastavi maksimalno mo¢

vigje.

Nastavitev parametrov obdelave pod drugacnimi nacini obdelave. Nacini obdelave
vkljuCujejo Citanje z laserjem, rezanje z laserjem in pikanje z laserjem. Bitna podlaga
se lahko obdela le z laserskim Citalnikom.
Nastavitev parametrov obdelave z laserskim Citalnikom

Ce izbere$ naéin obdelave z laserskim &italnikom, se prikaze naslednji meni.



Layer Parameter E] Layer Parameter g]

Iz Output: |Yes - . I= Output: |Tes -

Speed(mmfs): [100 Speed (nmfs); (100
Min Fower (%): |30 Min FPower (%): |30
Max Power (%1: |30 Max Fower (81: |30
If BElowing: Yas - If Blowing: YTes -
Processing Mode: Sean - Fraocessing Mode:

D Hegative ]
[ 1Ramp Effect

Eamp Length (mm]: Eamp Length (mm):
Owerstriking: Un—process - Owerstriking:
Secan Mode: |¥_swing - Secan Mode: |¥_swing -
Interwal (mm): (0.1 Interval (mm): |01
Offsetd (nm) : U Offzet? (un): |0 Offzetd (um) : U Offzet) (nm): |0
Advace Advace
Ok Cancel Ok Cancel

Vektorska podlaga (barvna podlaga) ne podpira negativnhega rezanja in optimiziranega
Citanja. Negativno rezanje: Ce ne izbereS negativnega rezanja, bodo Crne pike, ki se
pojavljajo po bitni mapi, odbijale laser. To ne velja za bele pike. Ce izberete negativho
rezanje, bodo bele pike, ki se pojavljajo na bitni mapi, odbijale laser. To pa ne velja za
¢rne pike.

Optimizirano Citanje: Ce izberete optimizirano Citanje, se bosta izboljSali nastavitev
Citalnega intervala in Citalni uCinek. DrugaCe naj bi izbrali Citalni interval, ki ga je
uporabnik nastavil za Citanje. ObiCajno izberemo optimizirano Citanje.

UCinek rampe: Ce izberete uCinek rampe, so robovi skeniranih podatkov lahko videti
kot rampa. S tem dosezemo trdni ucinek.

Minimalna moc, ki je trenutno nastavljena, ustreza moci zgornje rampe, maksimalna
moc¢ pa moci spodnje rampe. Isto vrednost nastavite lahko za maksimalno moc in
minimalno moc, Ce ne izberete ucinka rampe.

Dolzina rampe: dolzina rampe

Prepisovanje: vklju€uje Un-process, Intaglio in Rilievi

Ni obdelave: ne sprejema prepisovanja

Intaglio: ko izberete pisavo Intaglio (prosim, glejte spodnjo priponko), pisava se
prepisuje.

Pomnite: Ce izberete pisavo rilievi za prepisovanje pri izboru intaglio, bo pisava tanj$a
namesto debelejsa.

Rilievi: pri izboru pisave rilievi (prosim, glejte spodnjo priponko), se pisava prepisuje.
Pomnite: Ce izberete Intaglio za prepisovanije, bo pisava tanjSa namesto debelejSa.
Dodatno opozorilo: kaj sta pisavi intaglio in rilievi?

Pisava intaglio: besedilo nima zunanje meje. Samo besedilo se mora precitati.
Prosim, glejte spodnije slike:

Pisava rilievi: tekst ima zunanjo mejo, skenirati se mora osnova slike.



Welcome

Nacini skeniranja: vkljuCujejo unilateralizm X, swing X, unilateralizm Y in swing Y.
Unilareralizm X: Laserska glavica skenira slike naprej in nazaj v smeri ravni, vendar
odbija laser samo proti eni smeri. Na primer odbija laserska glava laser, ko se
skenira od desne proti levi, vendar ne odbija laserja, ko se skenira od leve proti
desni.

Swing X: laserska glava oddaja laser in Cita slike v vodoravni smeri naprej in nazaj.

Unilateralizm Y: laserska glava Cita slike v navpicni smeri naprej in nazaj, vendar
odbija laser samo v eni smeri. Na primer odbija laserska glavica laser med
skeniranjem od zgoraj navzdol, a ne odbija laserja, ko se skenira od spodaj navzgor.
Swing Y: laserska glava odbija laser in skenira slike v navpi¢ni smeri naprej in nazaj.
Pomnite: ponavadi sprejmemo nacin skeniranja swing X.

Interval: Laserska glava skenira interval med trenutno vrstico in naslednjo vrstico.
Manjsi je interval, temnejSe so skenirane slike, Ce pa je obratno, pa so slike SibkejSe
(svetlejSe).

Priporocilo: interval za cCitanje se nastavi pod 0.1 mm za vektorsko podlago (barvno
podlago). Interval za Citanje se nastavi nad 0.1 mm za bitno podlago. Minimalna in
maksimalna moc¢ se morata spremeniti, da dosezemo popoln u€inek skeniranih slik.

Nastavitev parametrov obdelave pikanja z laserjem

Pikanje z laserjem: risanje pik po slikah.

Kot prikazuje naslednja slika, izberite pikanje z laserjem kot nacin obdelave in v
meniju se bo prikazalo naslednje:



Laver Parameter @
Iz Output: |Tes - .

Speed(nmfs); |100
Wim Fower (). |30 Cas odbijanja laserja na eni
piki med obdelavo. Vecja je
vrednost, temnej3a je pika.
If Blowing: |Yes - Ce je obratno, je pika
svetlejSa.

Max Fower (%1 |30

Procezzing Mode: Dot - v

Dot time(s):
Interval med pikam
Dot interwal (um): |2 /‘ P

Dot lengthimm): |0

— | *Pikéasta dolZzina za rezanje
[Center dot prekinjenih ¢rt

Samo pika na sredini

Ol Cancel

Ponovno razvrs€anje podlag: klikni na gumb up, down lahko
spremeni vrstni red podlag, najprej se obdeluje zgornja podlaga.

II. 5.3 Pozicija

Nastavitev hrbtne lokacije laserske glavice po zaklju¢eni obdelavi (sedanja pozicija,
originalno sidro, stroj na niclo).

Sedanja pozicija: laserska glavica nazaj na pozicijo pred obdelavo

Originalno sidro: laserska glavica nazaj na zadnje sidro. Sidro se lahko nastavi na
ploSci.

Stroj na niclo: laserska glavica nazaj na nicelno pozicijo stroja.

[1.5.4 Go scale/cut scale

Slika prikazuje krog in rdeci pravokotnik zunaj njega je najman;jSi pravokotnik, klikni
na gumb »go scale« in laserska glavica ga bo obhodila.

_/

Slika prikazuje krog, ki ga obdaja rdeci pravokotnik, ki je najman;jsi. Klikni na »cut scale« in
laserska glavica bo obrezala pravokotnik.

I1. 5.5 Start, pause, stop, shrani pod datoteko UFile, izvozi iz datoteke Ufile, prenesi
Zacni/start: grafiko vnesi v stroj za obdelavo.

Miruj/nadaljuj (pause/continue): klikni na »miruj« in obdelava bo prekinjena nato spet klikni
na gumb za nadaljevanje (ang. »continue«).



Zaustavi/stop: zaustavi trenutno obdelavo.

Shrani pod datoteko UFile:

Shrani trenutno datoteko kot RD format za uporabo nespletne obdelave (za popolno nespletno
obdelavo jo lahko kopiramo na drug spomin).

Na primer: shrani krog.

|E| Savein: | (B} Desktop -3 F e -

BMY Documents

_,5 My Compuber
WMy Metwork Places
[IRDCAMSetp ¥3.0.2
|2 5endCanimand
[kt
m bar.rd

File marne:

Save az type: | *rd w

Izvoz iz datoteke Ufile:

Izvozi nespeltno datoteko (RD format)

Potem ko ste shranili nespletno datoteko, kliknite na »UFile output« in izberite datoteko RD
za obdelavo.

Prenesite (download):

Prenesite datoteko na spomin kontrolnika, nato uporabnik lahko za¢ne delati s strojno plosco.
11.5.6 1zvozi izbrane grafike

Potem ko ste preverili izvoz izbranih grafik, je boljse, da izvozite izbran del, kot pa da ne
izvozite neizbran del grafik.

[1.5.7 Optimizacija poti

Potem ko se je preverila optimizacija poti, pred izvozom samodejno optimirajte pot. Ce ste
pot ze optimirali oziroma po optimizaciji ni potrebe, potem lahko skrajsate ¢akalni ¢as, tako
da ne preverjate optimizacije poti.

11.5.8 Gibanje osi

Pri nadzoru osi lahko vsaki¢ nadziramo eno os.

Nastavite lahko informacije za gibanje osi, vklju¢no z dolzino gibanja, hitrostjo, vklopljenim
in izklopljenim laserjem in lasersko mocjo. Ce preverite gibanje iz prvotne tocke, potem
offset pomeni offset stroja na ni¢elno tocko. Ce gibanja od zacetka ne preverjate, potem offset
pomeni offset na trenutno pozicijo.

Pomnite: absolutna pozicija ni negativna v celotni $irini glede na predpise kontrolnika. Ce
preverjas gibanje od zacetka in nastavi§ negativno vrednost offseta, se bo stroj dotikal
omejevalnika.



Il. 6. poglavje
POGOSTO ZASTAVLIJENA VPRASANJA

Potem ko se je obdelava zacela, se stroj ne premika, nima motenj in ne gubi dele grafikov.
e Preveri, ali so podatki grafike izven okvirja. Podatki za okvirjem se ne bodo rezali.
e Preveri nastavitev pozicije laserske glave

11.6.2 Pri uvazanju datoteke programska oprema samodejno izklopljena

Ce je sistem delovanja XP, prosim, preverite, ali je nastavljeno stikalo.

11.6.3 Takoj$nja strojna plosca (manj odbojne razdalje)

Preveri hitrost rezanja v strojnem parametru. Obicajno rezalna hitrost ni 8000.
Poskrbi za to, da grafike niso blizu meje strojnega okvirja.

11.6.4 Obdelava grafik in sestrsko zrcalo dejanskim grafikom

Preveri »osno zrcalo« v okencu za splosne nastavitve (glej 4.2 splo$ne nastavitve).



11 NAVODILA ZA UPORABO LASERSKE PROGRAMSKE OPREME ZA
GRAVIRANJE IN REZANJE V.3.0

Uvod

Imamo dve vrsti laserske programske opreme za rezanje in graviranje. Ena temelji na
neposrednem izvozu programske opreme (v nadaljevanju laser CorelDraw), drugi pa temelji na
izvozu programske opreme AutoCAD (v nadaljevanju laser AutoCAD). Sledi predstavitev obeh
laserjev.

Il
1. poglavje
PREDSTAVITEV LASERJA CORELDRAW

Znacilnosti laserja CorelDraw

Uporablja se vecinoma Vv nadzoru gibanja. Je pomemben del nadzora gibanja laserja.
Laserskemu numeri¢nemu kontrolnemu stroju daje ucinkovit nadzor ter dokonca naloge v
skladu z Zeljami upravljalca. Spodaj so podane njegove funkcije in znacilnosti:

1. Laser CorelDraw je vtikalni modul namescéen v CorelDraw-u. Ima mocne funkcije
nacrtovanja in urejanja, kot sta na primer nastavljanje velikosti graficne podobe in
sukanje/vrtenje v krogu.

2. Podpira skoraj vse oblike zapisa datoteke, vklju¢no z vektorskimi oblikami zapisa (kot
sta PIt in Al) in bitno mapo (kot je BMP).

3. Prav tako podpira obliki zapisa datoteke DST in DSB (ki jih CorelDraw sam ne
podpira), in sicer z uvozom funkcije samega modula CorelDraw_Laser.

4. Podpira funkcijo sinteziranja (racunalnisko podprto spuséanje glasov) z uporabo uvozne
funkcije CorelDraw, s ¢imer sta za vedno omogocena izvoz in obdelava mnogih
dokumentov.

111.1.2 Okoljski pogoji

Priporocljivo nad CPUS586, PIIL, PIV

Priporoc¢ljiv spominnad 1 G

Priporoc¢ljivi Windows 2000 XP, Vista, WIN7, XP

Podpira programsko opremo CorelDraw 11 in CorelDraw 12, CorelDraw 13 in CorelDraw 14.

I11. Namestitev in zagon

I11. 1.3.1 Namestitev

Pred namestitvijo laserja CorelDraw Laser morate na vasem raCunalniku imeti nameScen
CorelDraw 11 ali CorelDraw 12. Ce ga nimate, potem najprej namestite CorelDraw1l ali
CorelDraw12 na vas rac¢unalnik.

Odprite CorelDraw11l ali CorelDraw 12, CorelDraw13 in CorelDraw14 in pred namestitvijo
zakljucite konfiguracijo.
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Slika

Kot prikazuje slika 1-1, pojdite v meni CorelDraw-a, izberite meni CorelDraw, nato kliknite
na orodja in opcije (ang. tools->options) in pojavil se bo meni, ki je prikazan na sliki 1-2.

1-1
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E
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= Workspace

- General

o Dizplay

- Edit

- Snap to Objects
o Dymamic Guides
< Warnings

- ¥BA

o Bave

- Memary

- Flug=Ins

b Taxt

b Toolbaox

[=)-Customization

ommand Bars
ommands

olor Palette
‘. Application

#- Document
% Global

Menu Bar

[ Context Menu Bar
Status Bar
Standard
Property Bar
Toolbox

[ Text

[ Zoom

[ Internet

] Print Merge

[ Transform

visual Basic For Applicati,..

Size
Bukkon: Border:
Srnall 1 -E-

Defaulk Button Appearance

|DeFauIt

Other
Shiow title when toolbar is Floating

l [ Zancel

I

Help

Slika 1-2



Kot prikazuje slika 1-2, izberite »vizualne osnove za uporabo« (ang. Visual Basic for
applications) in kliknite »OK «.

Slika 1-3 prikazuje glavni meni CorelDraw-a:

Orodna vrstica Visual Basic for
T4 applications - [B]X]
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Konfiguracija CorelDraw je zaklju¢ena, zaprite CorelDraw.
Da bi zagotovili gladko konfiguracijo, vam predlagamo, da najprej zaprete protivirusno
programsko opremo.

ROCAMSetup
A V3.0.2. exe
o Y RDCAM3.0 3.00 In. . L . .
Dvakrat kliknite na - in pojavil se bo meni za namestitev

programske opreme, kot prikazuje slika 1-4:

Welcom to use (X1 B ) Namesti USB

| Kijue

Install Driver/3EshaEdE 7

lvi VkljuCuje dve opciji: laser
CorelDraw_Laserin laser

Type/ZERl:  |CorelDraw_Laser | AutoCAD_Laser. Izberi CorelDraw_Laser
Larnage/iBE ; m»vmjuéuje tri opcije: poenostavijeno
_ s kitajsCino (Simplified Chinese),
[~ Locate install path/EfIREHE tradicionalno kitaj$&ino (Traditional
Chinese) in anglesc€ino (English).
Inctall/E8 |  Exit/iBH | Prosim, izberite jezik programske
opreme, ki ga potrebujete.

\ Za namestitev klikni na ta

gumb




5. Kliknina [Install Driver/3i&z24] za namestitev USB klju¢a. Ce se pojavi
okence z opominom v zvezi z namestitvijo strojne opreme, klikni »nadaljuj«
(ang. »continue«), dokler se namestitev ne zakljuci.

Hardware Installation

L4 E The =aoftware you are installing far this hardware;
[

IJSB Serial Converter

has not pazzed Windows Logo kesting ta werify itz compatibilitg
with YWindaws =P, [Tell me why this testing iz impartant. |

Continuing your installation of this zoftware may impair
or destabilize the correct operation of your system
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ LContinue Anway ] EéTDPInstallatinn |

Po namestitvi se pojavi naslednje okence, ki sporo¢a uspesno namestitev USB
kljuCev:

RLaserSetUp F§|

L
\lj) FTDI drivers have been install successfully installed!

Kot prikazuje slika 1-4, izberi CorelDraw_Laser, izberi jezik programske opreme in
klikni na namestitev. Pojavil se bo meni o uspesni nastavitvi, ki ga prikazuje slika 1-5.

RlLaserSetUp E|

\l) Install Finish!

Slika 1-5: obvestilo 0 dokonc¢anju nastavitve.

6. Dokoncanje nastavitve



lll. 1.3.2 Zagon (ang. Startup)
Odpri CorelDraw 11 ali CorelDraw 12 in pojavil se bo glavni meni CorelDraw-a, ki ga
prikazuje slika 1-6:

Tl Coceluiis 12 — [Geagiiel] M=K
||-] File Edit V¥iew Layout jrrange Effects Bitmaps Text Tools Window  Help - 0 X
low i 2, - 5| 1o b BN o

” A4 IE géggmm 2| & ulfn Units: | milimeters G 2,54 mm g: ggg mm & e okl
——| .. 300 200 100 [1} 100 200 300 400 millirmeters

I‘HE)‘ 8_: & . + M - E
Dl & —— |Orodnavrstica uporaba |aIserja

&, o

% ¥ 2 ——F Gumb za lasersko obdelavo

o, : :

g | Gumb|za namestitve !
B

25

| Gumb|za uvoz podatkoy DST/DSB

2l

0

7 X M
S |E]M + 10f1  + MY Pagel [ m

> ><
( 278,880, 335.665 )  Mext click for Drag/Scale; Second click for RokatefSkew; Dbl-clicking tool selects all objects; 5... @ - 4

Slika 1-6: glavni meni CorelDraw

Orodno vrstico »uporaba laserja« (ang. »Laser Using«) lahko vleCete samostojno na
pozicijo, Ki je po vasi meri, na primer, kot prikazuje slika 1-7:



Orodna vrstica uporaba laserja-Laser Using

A
Tl Curzlipiif 1% — [Geopiiul] \_i\.!]ﬂ‘
”-] File Edit View Layout Arrange Effects Bitmaps Text Tools Nindow  Help - O x
lppeavere o l@ua-gie @ vaExe i o|oms
” Ad D ;g 2}\0'2 fnm 29, |E||:| Igl Units: | millimeters r @ 254 mm 2 m, 632 mm g# 4131 'E||£1||71E |;I§
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Gumb za namestitye-Settings

” Gumb za uvoz p@datkov DST/DSB

=

millimeters

14 + 1of1 + MY Pagel 1] i

v
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{ 335.632, 352,567 )  Mext click for Drag/Scale; Second click for Rotate/Skew; Dbl-clicking tool selects all objects; 5., @
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